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In the spirit of trying new and exciting things in the year ahead, this month I 
decided to upend my column-writing strategy: Instead of writing about what-
ever’s stuck in my craw, I asked the folks following my Twitter stream to tell me 

what I should write about—a contest of sorts. The responses of my fellow Twitteri-
nos ranged from mildly kooky to wildly off -topic, and while there’s absolutely no 
way to write about everything suggested, I’m going to give it the ol’ Maximum PC 
try. Here we go.

  The fi rst respondent, @terryrobinson, wanted to know, “What’s 
next aft er we win the battle against DRM and GNU becomes the 
standard soft ware license?” Well, while I love your optimism, 
Terry, I think it’s much too early to dream of a post-DRM world. 
We’ve made good progress against DRM in music, but there’s a 
long road in front of us with respect to movie and game con-
tent. And no one’s even talking about electronic books, like the 
Kindle and its proprietary locked format. So while I’m sure we’ll 
one day live in a magical Internet wonderland fi lled with open 
content, free soft ware, and unicorns, for now at least, it remains 
a long way off .

  Fellow Rock Band afi cionado @strngwys wanted a column about 
how excited I am to unleash my inner Eddie Vedder when Ten 
is released this spring. No column required, stranger, just three 
words: REALLY, REALLY EXCITED.

  I can tell @wunderbar that I’ve never met a cupcake I didn’t like, 
but I recently learned that Sprinkles cupcakes are worth a 90-minute drive—espe-
cially if that’s what your wife wants for her birthday. I’m partial to the peanut butter 
ones; they’re best enjoyed with a tall glass of milk. 

  One of my coworkers, JT, wanted me to write about one of three subjects I’m 
wildly unqualifi ed to off er my opinion on: piracy off  the coast of Sudan, the 
International Monetary Fund’s role in diplomacy, or popcorn-eating hamsters on 
pianos. The hamsters are awesome, JT. AWESOME.

  Finally, @johntr wanted me to write about Twitter. While I might not know much 
about any of the aforementioned subjects in this column, I think I can safely say that 
I managed to knock this one out of the park. See you guys next month.

P.S.: People who sign up for my Twitter feed will have the only chance of winning in 
our Win a Tsotchke Trivia Contest. That’s right, I’m giving away all the cool vendor swag 
that’s sent to me, ranging from mouse pads to T-shirts to netbooks. The contest starts on 
January 20, so sign up soon! 

THINGS 
THAT ARE 
AWESOME!
HAMSTERS & PIANOS
www.youtube.com/
watch?v=tRzTfgds0UI

WILL’S TWITTER
http://twitter.com/willsmith

SPRINKLES CUPCAKES
www.sprinklescupcakes.com
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EA and Take-Two recently signed a 
deal to license Nvidia’s PhysX tech 
for use in upcoming games developed 

by both publishers. This move enables both 
publishers’ in-house development teams to 
utilize the full power of the PhysX API for 
materials simulation, more accurate ragdoll 
effects, and upgraded particle effects (like 
breaking glass). 

What does this mean for you? Well, 
if you own a GPU from the GeForce 9000 
series (or newer cards, natch), PhysX will be 
enabled automatically simply by updating to 
the most recent drivers. If you have multiple 
GPUs in your rig, you can even dedicate one 
to graphics rendering and use the second 
exclusively for physics acceleration. But 
with the relatively small number of games 
currently taking advantage of PhysX, we 
wouldn’t encourage anyone to do that right 
now. However, this new announcement 
could be the precursor to a flood of PhysX-
enabled titles coming in 2009 and beyond.

This announcement is a significant step 
forward for proponents of hardware-based 
physics acceleration. Getting developers 
to implement PhysX when the installed 
base was limited to a few thousand of 
Ageia’s dedicated cards was impossible, but 
with 150 million GPUs capable of running 
Nvidia’s implementation in the wild today, 

it’s worth developers’ time. 
Still, there’s a pretty big gotcha. Right 

now, ATI holds about 40 percent of the 
standalone graphics card market, and ATI 
cards don’t support PhysX acceleration. For-
tunately, ATI owners will still be able to play 
games that utilize PhysX. In addition to hav-
ing PS3, Wii, and Xbox 360 support, PhysX 

can also run on the CPU. However, PC gamers 
whose GPUs don’t support the API will have a 
greatly toned-down experience lacking nift y 
cloth eff ects and enhanced particle eff ects.

Therein lies the hitch. While we’re 
excited at the prospect of games supporting 

PhysX, without ATI (and likely 
Intel, with its forthcoming 
Larrabee part) supporting the 
API, we’re extremely unlikely 
to see games from major pub-
lishers that rely on hardware-
accelerated physics support 

for gameplay. Instead, PhysX will prob-
ably amount to little more than cosmetic 
enhancements in supported games—the 
same torn cloth, shattering glass, and fancy 
ragdolls that Ageia first showcased more 
than three years ago. We don’t expect to see 
games that require physics acceleration—no 
publisher will green-light a multimillion-

dollar title that will run on only 60 percent 
of PC gamers’ machines.

So what are the prospects of ATI imple-
menting PhysX and thus enabling physics 
acceleration using Nvidia’s API? According 
to Nvidia, “They [third parties] would have 
to develop a C compiler for their GPUs…. 
We encourage them to do that, but it is ulti-
mately up to them to develop that and make 
it work on their GPUs.” ATI’s response? “We 
remain committed to our partnership with 
Havok, as announced back in June.”

It remains to be seen whether EA and 
Take-Two will begin widespread develop-
ment of games using the PhysX API. We’re 
hopeful that one day developers will be 
able to harness the power of physics ac-
celeration in games; however, for the time 
being we’re skeptical that their recent deal 
with Nvidia heralds a new age of physics-
accelerated gameplay.

Mirror’s Edge is one of EA’s fi rst titles to fully embrace PhysX. When the PC version ships in January, 
Nvidia users will see tearing cloth, better glass, and a host of other physics effects.

THE NEWS
EA and Take-Two sign on to use the physics-acceleration API, but potential 
pitfalls remain for the fl edgling tech —WILL SMITH

Nvidia’s PhysX Momentum?THE NEWSNvidia’s PhysX Momentum?THE NEWS

PHYSX WILL LIKELY AMOUNT
      TO LITTLE MORE THAN
COSMETIC ENHANCEMENTS  
     IN SUPPORTED GAMES.



IBM’s MS 
Office 
Alternative
IBM, working in conjunction 
with Virtual Bridges and 
Canonical, hopes to save 
corporations a bundle (and 
make a tidy profit itself) by 
offering a virtual desktop 
package that will be free 
of Microsoft applications. 
Virtual Bridges is supplying 
the virtual desktop client 
while the Linux-based OS 
comes from Canonical. 

The Ubuntu-based suite 
will include a collection 
of offi ce, messaging, and 
collaboration apps, and 
IBM boasts that by going 
without Microsoft, companies 
could save from $500 to 
$800 per user on software 
licenses alone; further 
savings would come from 
reduced hardware demands, 
power consumption, and IT 
costs. All told, IBM claims, 
companies would see a 90 
percent savings in desk-side 
PC support and a 50 percent 
savings in help desk and 
software install costs. –TE

Maximum PC through the Ages
Google Book Search now includes complete OCR’d replicas of 
Maximum PC from 1998 to the present at http://tinyurl.com/6gzl5d.

DX10 on a CPU
Microsoft’s WARP10 bypasses old 
videocards 

If your graphics card doesn’t support DirectX 10 or 
10.1, don’t worry. Microsoft  is working on a new 

component called WARP10 (Windows Advanced 
Rasterization Platform) to be included in Windows 7 
that essentially ports DX10 duties to the CPU. 

The upshot is that anyone who can run Vista 
will have access to DX10 eye candy, even if their 
hardware doesn’t support it. Minimum requirements 
for WARP10 are the same as they are for Vista—an 
800MHz processor and 512MB of RAM. So if you 
have the hardware to run Windows 7, in theory you 
should be able to enable advanced eff ects regardless 
of your videocard. 

Microsoft  isn’t pitching WARP10 as a 
replacement for graphics, though. The rasterizer 
is intended as a diagnostic tool to help developers 
validate any visual artifacts as being rendering 
errors or problems with hardware or drivers. –PL

Imagine playing Crysis without the aid of a modern videocard!

Of course, this maga-
zine’s online presence 
extends far beyond 
Google’s searchable 
archive; remember, 
you can fi nd breaking 
news, exciting fea-
tures, product reviews, 
and PDF archives at 
MaximumPC.com. –KS

Tom Halfhill was formerly a senior editor 
for Byte magazine and is now an analyst for 
Microprocessor Report. 

No doubt you’ve heard that analog TV in 
the U.S. goes off the air on February 
17, replaced by digital TV. If you haven’t 

heard, you must be in a coma. Four times as 
much money has been spent to prepare Ameri-
cans for this transition as the U.S. government 
spends on adult education each year. Who says 
politicians can’t get their priorities straight?

I’m dreading the switch. I’m a diehard who 
still plays vinyl records, subscribes to a daily news-
paper, and snatches free TV from the ether with 
rabbit ears. And I’m not alone. Thirteen percent of 
U.S. households still depend on TV antennas.

Although the DTV transition won’t affect 
people who have cable or satellite TV, it does 
reveal an inherent flaw of digital technology. This 
flaw afflicts almost all digital media, includ-
ing the digital photos you take, the digital video 
you record, and the digital music you download. 
Digital data can be rendered useless by minor 
damage that wouldn’t matter if the media were 
in analog form.

At my home, for example, DTV is a bust. 
NBC is the only network my indoor antenna can 
receive. CBS, ABC, and PBS are dead air. Yet 
my antenna points toward the region’s largest 
hilltop broadcast tower, just 10 miles away. For 
years I’ve received analog TV that’s a little snowy 
but quite watchable.

The problem is that DTV signals are typical 
of digital media. They are all or nothing. If any-
thing interferes with the compressed bitstream 
of ones and zeroes, the error-correction algo-
rithms may not be able to reconstruct the lost 
data. So, when a digital TV gets a weak signal, it 
doesn’t get a snowy picture—it gets no picture. 
The same errors can make digital photos, videos, 
and music unreadable. I’ve seen JPEG files ir-
retrievably scrambled by a single data error.

By comparison, analog media are more 
robust. I’ve scanned 100-year-old photographic 
negatives that were scratched all to hell, but 
they still yielded usable images. I have restored 
60-year-old acetate recordings that sounded like 
popcorn but were still audible.

To protect your digital media, keep multiple 
backups. Although this solution doesn’t apply to 
DTV, it will help preserve your digitally stored 
memories.

FAST FORWARD

Requiem for Analog TV

TOM HALFHILL
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My fi rst thought was, “Aw, not this crap 
again!”
I was somewhere in the second location 

of Tomb Raider: Underworld. There was a jump 
that needed to be made—there’s always a jump 
that needs to be made—and every time I tried 
to get the right angle, the camera disappeared 
into Lara Croft’s gigantic backside like a twitchy 
colonoscope. If I turned a little bit, Lara herself 
vanished into the rocks.

Twelve years on, and with Tomb Raider 
creator Core now little more than a stack of deval-
ued assets, the problems that plagued the series 
are still haunting Lara Croft like the Ghosts of 
Polys Past. Underworld is a creaking old hulk of a 
game, building very slightly on Legend’s meager 
innovations but still delivering most of what fans 
expect: running and jumping, some combat, 
puzzles, and Dr. Lara.

Then I turned to Mirror’s Edge and could not 
imagine two more sublime contrasts. It is the 
anti-Tomb Raider. Faith is Bizarro Lara: a wispy, 
mopey Asian goth with the body of an anorexic 
12-year-old boy. Everything about Mirror’s Edge 
is fresh and new, from the bright whitewashed 
concrete and dazzling sky of the setting to the 
groundbreaking running and jumping controls. 
The sensation of motion and the feeling of 
control is something actually innovative. Not in-
novative in the sense of “really good and a little 
bit new,” but a by-gum fresh way of interacting 
with a game world.

And I hated it. Oh, how I hated it, with a 
hatred that burned hot and radioactive like the 
Springfi eld reactor. Put aside the insipid story, 
characters, and social critiques, and you have a 
maddening kind of Stockholm-syndrome game-
play that tries to convince you that repeatedly 
plummeting to your death when you fail to pull off 
improbable moves is actual entertainment.

Just for laughs, I returned to Underworld 
after I escaped from Mirror’s Edge, and you know 
what? I found myself enjoying my time with the 
old girl. Gamers are like middle-aged men (and 
I’m both): They may look at the skinny, quirky new 
girl, but they always stick with the solid, reliable 
woman in the end.

GAME THEORY

Tomb’s Edge

THOMAS MCDONALD

Thomas L. McDonald has been covering games 
for 17 years. He is an editor at large for Games 
magazine. 

Having achieved only modest market 
share with its subscription-based 
OneCare PC security plan, Microsoft is 
switching gears and offering consumers 
a free antivirus app beginning mid-
2009. Code-named Morro, the app will 
focus strictly on malware protection 
versus OneCare’s combo of AV, system 
maintenance, and data backup; it will be 
available for XP, Vista, and the upcoming 
Windows 7 OS. 

Microsoft says its motivation is to get 
antivirus protection on more PCs. But the 
company has no plans to bundle the app 
with Windows. Rather, it will be available 
for download, which should help the 
company avoid any antitrust fl ak.

Are AV heavyweights McAfee and 
Symantec worried that Microsoft’s free 
app will lure their paying customers? 
Representatives for both companies 
say no. As Symantec’s Senior VP of 
Consumer Business Rowan Trollope 
puts it, “We view this announcement 
as a capitulation by Microsoft and a 
reinforcement of the notion that it’s 
simply not in Microsoft’s DNA to provide 
high-quality, frequently updated security 
protection…. Making a signifi cantly 
scaled-back version of that same 
substandard security technology free 
won’t change that equation.” Ouch. –KS

Microsoft to Offer 
Free Antivirus App
Company pulls plug on 
OneCare

IM Flash Technologies, a company jointly owned 
by Intel and Micron, has developed the smallest 
NAND process geometry on the market. Using its 
34nm process, IMFT will begin mass production of 
32Gb multilevel-cell NAND fl ash chips in June to 
be used in a variety of portable devices, as well as 
solid state drives with double the storage capacity 
of today’s SSDs. –KS

PHENOM II X4 IMMINENT 
AMD’s 45nm shrink promises far more clock 
headroom than before

Don’t call it P-II. AMD is expected to release a 45nm shrink of its Phenom CPU, 
which will be called Phenom II X4. Although AMD wouldn’t comment on the CPU, 
leaked info suggests that the X4 should come in a 3GHz version with 8MB of 
cache and oodles of overclocking headroom.

The original 65nm-based Phenom performed well but couldn’t compete with 
the frequencies of Intel’s Core 2 chips. That may change with Phenom II, which 
will likely run at 4GHz on air and 6GHz on liquid-nitrogen. 

How Phenom II will perform against Intel’s Core i7 is unknown, but the 
former should be a winner in the budget department. Initial Phenom IIs will 
drop into many existing and affordable AM2 and AM2+ motherboards and use 
thrifty DDR2 memory. –GU

QUICKSTART THE BEGINNING OF THE MAGAZINE, WHERE ARTICLES ARE SMALL

Intel, Micron Make Smallest NAND chip

OneCare won’t be 
sold after June 
2009, but customers 
will be protected 
through the life of 
their subscription.
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LCD Makers Admit to 
Price Fixing
Penalties in excess of $500 million

LG, Sharp, and Chunghwa recently pleaded guilty to 
charges of conspiracy in an attempt to keep the price 
of LCD panels artifi cially high; the companies will pay 

$585 million in fi nes, with LG paying $400 million of that total. 
The U.S. Justice Department charged LG and Chunghwa with 
conspiracy for meeting to discuss prices and exchanging 
sales information. Sharp was charged with three counts 
of conspiracy to fi x prices of panels sold to Dell, Motorola, 
and Apple. This isn’t the end of the issue, however. All three 
companies face a number of class action suits from affected 
parties, and the European Union also has yet to weigh in on 
any fi nes for the companies. –TE

Time to dust off 
your aged Voo-
doo3 videocard.

3dfx Drivers Updated

If you’ve long been hanging on to an old 3dfx 

Voodoo videocard for sentimental reasons, you can 

now feel justifi ed in your unhealthy attachment. 

That’s because although 3dfx has been defunct 

for years, a dedicated legion of fans lives on in the 

form of 3dfx Zone (www.3dfxzone.it), which recently 

released updated drivers for 3dfx cards to work with 

Windows 2000/XP 32-bit or XP x64. Based on a unifi ed 

architecture, the SFFT 1.5 driver package works with 

multiple 3dfx GPUs, including the entire Voodoo3 family 

as well as the VSA-100 Voodoo4 and 5 cards. –KS

Usually, I don’t write about Google, because 
googling it is so hard. But ambiguity isn’t 
enough to thwart my interest in Google’s 

recent movement in the world of books. Google 
Books (originally Google Print) has come to a 
settlement with publishers that will, in essence, 
make it the default collecting society for out-of-
copyright books—with no congressional oversight.

It’s the result of 1337 legal hacking. In 2004 
Google announced plans to scan in-copyright 
books that were part of university holdings, some-
thing no other book scanner had talked about 
doing. In 2005 the publishers and authors sued 
Google in a move that sent waves of not shocked at 
all through the copyright community. It was closely 
watched by sad copyright wonks (moi) as possibly 
defi ning fair use online.

Google skipped all that and instead suggested 
amassing a library no one could duplicate and 
selling the books. The publishers went along for a 
cut of the action. Thing is, because Google settled, 
it’s a deal only Google gets.

This leaves access to most 20th century books 
to one company. On the one hand, someone is 
fi nally scanning and making orphan works avail-
able to the world. Isn’t it better that they exist at 
all, even if it would take a crack team of pirating 
ninjas to sneak them out of the Google machine 
rooms?

Maybe not. Google has closed the door 
behind them, and other public-trust scanning 
projects, governmental and nonprofi t, are left 
out in the cold.

Organizations like Openlibrary.org have 
always wanted to create a universal library for 
all. Google’s always wanted to control a universal 
library for all. As well it should be—Google is a 
company, and to the extent that it’s a steward of 
our cultural heritage, its fi rst purpose is to make 
its shareholders richer. Doesn’t that sentence 
make you feel icky?

Some say companies are the best way to 
protect our culture. As a fan of the Library of Con-
gress, NASA, NOAA, the USGS, the Park Service, 
etc., I disagree.

The deal still has to be approved by the 2nd 
Circuit Court in New York—then it’s one for the 
sad antitrust wonks to watch.

BYTE RIGHTS

From Orphans to 
Captives?

QUINN NORTON

Quinn Norton writes about copyright for Wired 
News and other publications. Her work has 
ranged from legal journalism to the inner life 
of pirate organizations.

any fi nes for the companies. –TE

HP 
Prototypes 
Memristor 
Chip
Memristors, the fourth 
fundamental circuit 
(after capacitors, resis-
tors, and inductors), 
have been theorized 
since UC Berkeley 
Professor Leon Chua 
predicted their exis-
tence in 1971, but it 
wasn’t until April 2008 
that Hewlett-Packard 
Labs built a working 
memristor prototype. 
Memristors are nano-
scale switches that act 
as logic gates, but with 
a twist—they “remem-
ber” their state even 
when powered down, 
so they can perform 
calculations and act as 
nonvolatile memory. 

In November, HP 
announced a prototype 
chip that incorporates 
both transistors and 
memristors—the fi rst 
of its kind—and though 
it’s a long way from 
a production model, 
it points to future 
applications in neural-
net-type processors, as a 
replacement for volatile 
RAM, and eventually 
as even a processor/
memory hybrid. 

HP’s memristor 
prototypes are built on 
a 15nm scale—much 
larger than the 4nm HP 
thinks it can achieve but 
already smaller than the 
45nm process of modern 
chips. And even though 
current memristor-
chip prototypes run at 
about a tenth the speed 
of DRAM, we expect 
Moore’s Law to kick 
in any day now. We 
wouldn’t be surprised 
if, thanks to memristors, 
the computers of 2018 
look nothing like 
today’s. –NE 
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THOMAS MCDONALDTHE LIST9 Tech Developments THE LIST9 Tech Developments THE LIST to Watch 
for in 2009
9 Tech Developments 
for in 2009
9 Tech Developments 

7 Up to 4.8Gb/s bi-
directional transfer—
a tenfold increase in 
speed from USB 2.0. 6 The many-cored GPU archi-

tecture with a shared cache 
is perfect for distributed 
computing tasks.

8LINUX ON 
THE DESKTOP9 AMD’s been working 

feverishly to get its 45nm 
next-gen chips out of the 
fabs and into our PCs.

PHENOM II

USB 3.0       LARRABEE

3SECOND-GEN 
NETBOOKS

The fi rst generation impressed us 
with their small sizes and good price/
performance ratios. Now let’s work 
on the battery life!

2BETTER SOLID 
STATE DRIVES

Watch as storage-capacity increases 
and the price per gigabyte drops.

Nanoscale switches with variable resistance and persistent memory can 
replace transistors in circuits, and now HP has built a hybrid memristor-
transistor chip prototype. This won’t become commercialized in 2009, but 
expect big strides in both calculation and storage if these take off.

1       
THE DESKTOP

MEMRISTORS

5BETTER OLEDs 
Organic LED displays are fl ex-

ible and don’t need current to stay 
bright—and now blue OLEDs fi nally 
last as long as reds and greens.

4ANDROID 
 Sure, the G1’s already here, but 

it’s no iPhone killer. Expect one in 2009, 
once the OS matures and manufactur-
ers turn out second-gen handsets.1       1       1       1       1       1       1       1       1       1       BETTER OLEDs 

9 fabs and into our PCs.



16 | MAXIMMAXIMMA UXIMUXIM MUMU PCPCP | FEB 09 | www.maximumpc.com

DEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCHDEATHMATCH

WESTERN DIGITAL 
VELOCIRAPTOR 300GB
$300, www.wdc.com

ROUND 1
SPEED

Hard drive speed isn’t the 
most important factor to 
consider when build-
ing your dream PC, but 
there’s no denying that a 
faster hard drive equals 
better performance. The 
10,000rpm WD Velocirap-
tor is the fastest consumer 
hard drive on the market 
(excluding SSDs), reach-
ing burst read speeds of 
249MB/s in HD Tach, with 
average reads hovering 
around 108MB/s. While 
the 7,200rpm Barracuda’s 
burst speeds are 20 percent 
slower than the Velocirap-
tor’s, the former manages 
to eke out average reads of 
104MB/s, and its average 
write speeds are actually 
about 3 percent faster than 
the Velociraptor’s. The Ve-
lociraptor’s random-access 
speed, though, was twice 
that of the Barracuda’s in 
our tests. 
WINNER: VELOCIRAPTOR

ROUND 2
CAPACITY

The Raptor line has always 
favored performance over 
capacity; 2003’s model had 
a scant 36GB of storage. 
And while you still won’t 
buy a Velociraptor for its 
size, the latest model of-
fers a respectable 300GB of 
storage—enough for your 
operating system and quite 
a few movies and games. 

Nevertheless, the 
Seagate Barracuda 1.5TB 
drive has this category 
locked up. Not only does 
its capacity trounce the 
Velociraptor’s by a factor 
of five, but it’s also half 
again the size of the tera-
byte drives that are its 
closest competitors. 
WINNER: BARRACUDA 

Western Digital Velociraptor 
vs. Seagate Barracuda 1.5TB 
The age-old dilemma: speed or capacity? In the days of yore, 

men spoke in whispers of enterprise drives, which married 
the two, but lesser mortals had to choose between large amounts 
of storage and speedy access to data. The gap, at least within 
the realm of standard hard drives, is narrowing—today’s high-

capacity drives often have read times that are within spitting 
distance of the speediest consumer drives, a title Western Digi-
tal’s Raptor line has held for years. This month, we pit Seagate’s 
1.5-terabyte Barracuda against this generation’s 300GB Western 
Digital Velociraptor. –NATHAN EDWARDS

QUICKSTART THE BEGINNING OF THE MAGAZINE, WHERE ARTICLES ARE SMALL
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And the Winner Is...

We love the Velociraptor—the speed and reliability of the Rap-
tor line are legendary for good reason. But we have to give 

the Seagate Barracuda 1.5TB more props for sheer size and value.
If we had our druthers, we’d say get both drives—the Velocirap-

tor for your OS and speed-sensitive applications and games, and the 
Barracuda for media storage and backup. But if you can aff ord only 

one drive, the Barracuda’s the way to go.
At 12 cents per gigabyte, with nonburst speeds approaching 

those of the Velociraptor, Seagate’s drive off ers the perfect combina-
tion of size and performance at a killer price. Who could ask for 
anything more?  

SEAGATE BARRACUDA 7200.11 1.5TB 
$225, www.seagate.com

ROUND 3
RELIABILITY

Some 1.5TB Barracuda 
drives suffered intermit-
tent random pauses in OS 
X, Linux, and Windows 
Vista, but Seagate has 
since issued a firmware 
fix that seems to have re-
solved the problem. 

Both the Barracuda 
and Raptor have long-
rated life spans. The Sea-
gate Barracuda is rated 
at 750,000 hours MTBF 
(mean time before failure, 
or average life span), 
which is impressive, but 
the Velociraptor, built to 
enterprise drive stan-
dards, sports an MTBF of 
1.4 million hours.
WINNER: VELOCIRAPTOR

 Western Digital Seagate Western Digital Seagate
 Velociraptor Barracuda Velociraptor Barracuda
 Western Digital Seagate
 Velociraptor Barracuda
 Western Digital Seagate Western Digital Seagate
 Velociraptor Barracuda
 Western Digital Seagate

Size 300GB 1.5TB 300GB 1.5TB

HD Tach Burst (MB/s) 249.7     209.3

HD Tach Random Access (ms) 7.1 15.2

HD Tach Average Read (MB/s) 108.4 104.4

HD Tach Average Write (MB/s) 100.0 103.8

PCMark05 Overall 9,450    5,093

Best scores are bolded. HD Tach version 3.0.1.0 used.

BENCHMARKS

ROUND 4
PRICE PER GIGABYTE

The 300GB Velociraptor 
will cost you about $280 
(street price), or 93 cents 
per gigabyte, while the 
1.5TB Barracuda can be 
found for $180—about 
12 cents per gigabyte. 
That’s a big difference, 
especially considering 
the Barracuda’s more-
than-respectable read 
and write performance. 
In fact, it’s hard to fi nd 
any hard drive with a 
better price/capacity or 
price/performance ratio 
than the Barracuda. 
WINNER: BARRACUDA



Battery Not 
Refilled—or Returned
It finally happened to me. 
I needed a new battery for my 
son’s Sager laptop, so I decid-
ed to try BatteryRefill.com. 
You ship them your old bat-
tery; they “refill it” and send 
it back to you. My credit card 
was charged in early October 
and, per the company’s 
instructions, I sent the old 
battery to them three days 
later. The company emailed a 
receipt for the battery a week 
after that.

Since then, I’ve had only 
one contact with the com-
pany (despite my repeated 
attempts), and the person I 
spoke with over the phone 
said the battery would be sent 

within five to seven business 
days. You can guess what hap-
pened: nothing.

I know, I should have 
known better. I just checked 
the BBB and saw that 
BatteryRefill.com has an F 
rating. I should have checked 
this first. Can you help me 
get both my money and bat-
tery back? 

—Doug Novin
 

Unfortunately, Doug, like you, 
the Dog was unable to reach any 
humans at BatteryRefill.com. 
You’re right though, BatteryRefill.
com gets a big, fat F from the 
Better Business Bureau, with 82 

complaints racked up in the last 
36 months. The BBB indicates 
that the Ontario, CA, company 
operates under the name eBat-
tery and lists Kay Choi as the pri-
mary contact. Unfortunately, the 
Dog was unable to reach a repre-
sentative by following those 
leads. A single online search, 
however, revealed numerous 
posts warning about the compa-
ny’s poor service. As far as the 
Dog can tell, the company has 
had a hit-or-miss record with 
customers over the years. At 
Resellerratings.com, some cus-
tomers reported being pretty 
tickled to get refilled batteries 
very cheap while others had 
hair-pulling experiences similar 
to yours. 

Obviously, what you 

should do is immediately call 
your credit card company and 
dispute the charges. As for the 
battery, you probably won’t 
get it back, but at least it was 
dead, so it has fairly low value. 
The lesson for all of us is to do 
a little research before making 
a purchase.

OS out of Service
After more than 10 years of 
building PCs as a hobby, I did 

not know that an OEM copy 
of Windows dies when the 
computer it was installed 
on is dismantled. A friend of 
mine had his 3-year-old Dell 
damaged beyond repair. As 
a Maximum PC reader, I told 
him to build a new machine 
and recycle the parts from 
the old PC. The hard drive, 
DVD drive, and graphics card 
made the jump, but when 
I called to reactivate the 
Windows XP license, I was 
told I could not use it since it 
was a preinstalled copy and 
the license dies when the 
computer it was on dies. 

Is that correct? I always 
believed that when I pur-
chased a computer with an 
OEM version of Windows, I 
also purchased a full license 
for the OS—not just a “tem-
porary” one.

What happens if I 
buy a computer and then 
install Linux right away: 
Would I be able to legally 

use the Windows license 
that came with the com-
puter on another machine? 
Apparently not. So why am 
I allowed to buy an OEM 
version of the OS purchased 
with a computer compo-
nent, such as memory or a 
hard drive? The same situ-
ation doesn’t seem to apply 
in the latter case, unless 
Microsoft is able to verify 
that I’m still using my OEM 
OS with the component 
it was purchased with. 
Something doesn’t seem 
right to me. Please shine 
some light on this issue.

—Michele Persiani

You bring up a good point, 
Michele. Microsoft allows stores 
to sell copies of OEM OSes with 
single part purchases, such as 
a hard drive, mouse, or even a 
Y-splitter cable, so what hap-
pens to the OS when you swap 
out that part? Here’s the skinny: 
Regardless of whether you buy 

Our consumer advocate investigates...

BatteryRefill.com out of Refills?BatteryRefill.com out of Refills?BatteryRefill.com out of Refills?OS LicensingBatteryRefill.com out of Refills?OS LicensingBatteryRefill.com out of Refills?

Recall Roundup

WATCHDOG MAXIMUM PC TAKES A BITE OUT OF BAD GEAR
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 IF THE HARD DRIVE TAKES A   
      DUMP, IF THE VIDEOCARD OR  
 NIC DIES, NO PROBLEM, YOU 
         HAVE THE OS REACTIVATED.

EMAIL THE WATCHDOG If you feel you’ve gotten a raw deal and need assistance 
setting a vendor straight, email the Dog at watchdog@maximumpc.com. Please 
include a detailed explanation of your problem as well as any correspondence you 
have sent concerning the issue.

BatteryRefi ll.com has a bad reputation with numerous consumer sites.



your OEM OS with a PC or just 
a single piece of hardware, 
Microsoft considers the OS tied 
to the motherboard it’s first 
installed on. If the hard drive 
takes a dump, if the videocard 
or NIC dies, no problem, you 
can have the OS reactivated. 
However, if the motherboard 
the OS was installed on fails, 
Microsoft can consider it 
deadski. In some cases, the 
company will reactivate a 
dead board’s OS—say, Dell 
has a run of bad boards on 

some machines and it has field 
techs replace the bad mobos. 
The Dog has also heard stories 
of Microsoft being flexible in 
enforcing the OEM rules. The 
company might let you slide, 
for instance, if you bought 
an OEM copy of the OS and 
installed it on subsequent 
home-built rigs, but trying to 
use a product key from an OEM 
PC, like a Dell, on your home-
built rig is not going to fly. That’s 
probably because while you 
and I might pay $100 for an 

OEM copy of XP, Dell, HP, and 
other large vendors pay sub-
stantially less.

So, no, you would not be 
allowed to use your copy of 
Windows XP from a new OEM 
machine if you installed Linux. 
Some companies will allow 
you to buy a machine without 
an OS, however, if you intend 
to install Linux. Retail copies 
of Microsoft’s OSes do not die 
and can be transferred to a 
new machine an unlimited 
number of times. 

 DYMO is recalling some 17,000 

power adapters sold with its printers 

that may create a power surge that 

overheats the printer and poses a 

burn hazard. The adapters were 

sold with the DYMO LabelWriter 400, 

DYMO LabelWriter 400 Turbo, DYMO 

Label Writer Twin Turbo, DYMO 

LabelWriter Duo, and DYMO Desktop 

Mailing Solution.

If you have one of these print-

ers, examine the power adapter and 

look for a date code of 2407, 2507, 

2607, or 2707 and make sure the 

adapter does not have a RoHS symbol—these are the indicators of an impacted 

brick. Any adapter bearing the RoHS symbol, even if it has one of the above date 

codes, is not part of this recall.

If you have a bad supply, you should unplug it from the wall and contact DYMO 

for a free replacement. Call DYMO at 888-658-3904 between 9 a.m. and 8 p.m. 

Eastern Time or visit http://global.dymo.com/poweradapter. 

Battery-Biz is recalling about 1,300 

notebook power adapters that may 

fail, overheat, and pose a burn hazard. 

The company said about five people 

have complained about the batteries 

overheating. The adapters are marked 

Duracell Universal Power Adapter. 

The recall applies to the 130-watt combo AC/DC version with the model numbers 

EA10900, AC-6501, and DRUM130 and date codes 0804 and 0805.

The bad adapters were sold through Dell.com and Duracelldirect.com between 

February and March last year for $80 to $120. Anyone with a recalled adapter should 

stop using it and contact Battery-Biz at 800-780-6552 between 7:30 a.m. and 4:30 

a.m. Pacific Time Monday through Friday.

RECALL  ALERT

This power brick with 
the date code of 2407 
and without the RoHS 
symbol is bad.

DYMO printer adapters 
with the RoHS symbol 
are good.



  Give Windows a   

When you can’t fi x it. When you can’t repair it. When you can’t even 
boot, it’s time to reinstall your OS—the right way. We’ll show you how
BY GORDON MAH UNG
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Clean start. OS reset. Nuke and pave. Whatever you call 

it, no matter how good a personal system administrator 

you are, there’s a time to take your OS install out behind 

the shed and put two in its head.

When would you need to take such extreme mea-

sures? If the networking stack is splayed out on the fl oor 

and no amount of patching, registry editing, or Winsock 

repair tools can fi x it. If you can’t get hibernate or stand-

by to work anymore. Or if you’ve had a horrible mal-

ware or rootkit breakout. Sure, you may have reclaimed 

control of your PC aft er an epic fi ve-day battle with the 

beast, but can you really trust your OS anymore? You 

don’t want to reenact the fi nal sequence from The Thing, 

you and your PC eyeing one another wondering if the 

other is not what he seems to be.

A clean start is the only way to relieve your para-

noia. It can also save you countless hours of trouble-

shooting and tweaking a misbehaving machine. Fol-

low along as we instruct you on the proper way to do 

a clean install—whether you’re using XP or Vista—that 

will have your OS acting like the young pup it once was. 

Plus, we’ll show you how to create a pristine image of 

your OS that’ll save your bacon the next time your rig 

melts down. 



www.maximumpc.com | FEB 09 | MAXIMMAXIMMA UXIMUXIM MUMU PCPCP | 25

IL
LU

ST
R

AT
IO

N
 B

Y 
AD

AM
 B

EN
TO

N

  For that New 

Hard 
Drive 
Smell!



26 | MAXIMMAXIMMA UXIMUXIM MUMU PCPCP | FEB 09 | www.maximumpc.com

BUY SOME BREATHING ROOM
You can do a clean start using just your old drive and a pile 
of DVDs for backup, but we recommend that you use our 
method and buy two new hard drives. You’ll use one as 
your new C: drive and the second to store your backups 
and images. (Consider the original drive as a backup of 
all your data up to this point.) Here’s our reasoning: First, 
an OS reinstall is the perfect time to make the jump to 
a new drive. Second, the performance benefits of your 
clean install will only be enhanced by using a newer, 
larger drive. The new 1.5TB Seagate Barracuda, for 
example, has an average read speed of 104MB/s. Your old 
500GB drive probably tops out in the 50MB/s to 60MB/s 
range, depending on the generation of the drive. You’ll 
also see significant performance benefits if you have a lot 
of data because a drive’s performance weakens as it ap-
proaches full capacity—so that 400GB of data on a 1.5TB 
drive or even a 1TB drive won’t impinge performance as it 
would on a 500GB drive. Finally, storage has become one 
of the most inexpensive components in a PC. So take our 
advice and spend the $200 on two new 1TB drives and 
save yourself some heartache. 

If you choose to ignore our advice and reinstall the OS on 
your original drive, you must back up all your data to discs 
before proceeding. 

TAKE STOCK OF YOUR APPS
Before you make a clean start, you need to consider the ap-
plications you’ll be bringing with you. First, make sure you 
have all of your application discs. One of the most impor-
tant tasks is to take stock of any registration codes that you 
need for your soft ware. Locate and record the registration 
keys that you will need. If you can’t fi nd the keys, try Magic 
Jelly Bean 2.0, a free utility available at Download.com or 
Sourceforge.net. The application will search through the 
registry for application keys. It won’t fi nd all the keys you 
need, but it might help you locate that one key you can’t fi nd. 
Magic Jelly Bean 2.0 is sometimes identifi ed as a hacking tool 
by antivirus apps, but if you download it from a reputable 

Out with the Old, in with the New
Before embarking on our clean start regimen, read through the instructions to make sure you 

have all the tools you’ll need and a thorough understanding of the process

Software activation is the harsh consequence of software 

piracy. Fortunately, it’s merely an inconvenience, not a major 

undertaking. To minimize your reinstall efforts, you should 

take stock of the applications that require activation before 

you do your clean start. Most professional Adobe applica-

tions require that you deactivate the program before it can be 

installed elsewhere. To do this, click Help and then Deactivate. 

This should deactivate the suite, but to be safe, fi re up your 

other Adobe apps and check to see if they have been deacti-

vated. You’ll need Internet access for the application to talk to 

Adobe’s servers. Adobe’s activation is more fi nicky than the 

one Microsoft uses, and disk changes, such as imaging from 

one drive to another, can trigger activation. For other pro-

grams, you may want to research how the individual software 

vendor treats reactivation. Microsoft Offi ce 2007 can simply 

be reinstalled on your new hard drive and reactivated. You’ll 

likely have to reactivate by phone though, as the program may 

fail an Internet reactivation. Just explain that you are install-

ing to a new hard drive and you should be fi ne. Not all vendors 

are as accessible, however, so if there is a critical application 

that you need access to, you may want to contact the vendor 

fi rst to fi nd out what the activation policy is. Obviously, if you 

don’t know if the program will reactivate and you need to ac-

cess it, wait until you have the answer before you do your clean 

start and consider doing your reinstall during normal business 

hours when the vendor can be contacted.

FIRST THINGS FIRST

Deactivate Application Activation

Magic Jelly Bean 2.0 may help you locate serial numbers you’ll 
need to reinstall your applications.

clean start
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site such as Download.com, you 
should be fi ne. If you can’t locate a 
particular key, contact the vendor 
for a replacement key or a copy 
of your original key before you 
proceed if you know you’re going 
to need access to the app. You did 
write down your Windows XP or 
Windows Vista key, right?

DEACTIVATE 
YOUR APPS
Many applications require activa-
tion before running—even if you 
have a legitimate serial number. 
You can’t, for example, reinstall 
Photoshop without reactivating it, so deactivate any programs 
on your old drive that use this copy-protection technique (for 
more information on deactivation see our sidebar on page 26).

PREP ITUNES AND STEAM
Moving your iTunes library is fairly easy, but it can be made more 
complicated by diff erences among versions. If you’re running 
iTunes 7 and plan to use iTunes 8 on your clean install, we suggest 
that you install iTunes 8 on your existing hard drive fi rst. It doesn’t 
always happen, but people have reported issues migrating the da-
tabase from iTunes 7 to iTunes 8. You should also consolidate your 
library by going to File > Library > Consolidate Library in iTunes. 
This will copy the various music and video fi les that are scattered 
around your PC into the iTunes directory at C:\Documents and 
Settings\your user name\My Documents\My Music\iTunes (or C:\
Users\your user name\Music\iTunes on Vista). Once you’re done, 
migrating your library is as easy as copying the iTunes folder 
of your old drive into the \My Documents\My Music\ folder of 
your new drive. Your fi nal move in iTunes will be to turn out the 
lights. In iTunes, go to Advanced > Deauthorize and deauthorize 
the computer. This will prevent you from playing any protected 
content that you downloaded from iTunes on your PC until you 

have reauthorized the computer on your new OS install.
Likewise, if you have any games using Valve’s Steam ser-

vice, we recommend that you use the program’s built-in backup 
feature to create a backup of your games folder. Generally, just 
copying the entire Steam directory over to the new install will 
work, but having the backup fi le will help should you encounter 
problems. While the old drive is up and running, you should 
hunt down any saved games you want. We can’t tell you where 
to fi nd the saved games for each particular title, as developers 
use diff erent locations. Check the individual C:\Program Files\
game name folders to see if the saved games are there, if they 
aren’t in a subfolder of Documents.

COLLECT YOUR DRIVERS
Gather all the driver discs for the peripherals connected to your 
PC. If you can’t fi nd a particular disc, chances are you can get the 
driver off  the manufacturer’s website. There’s no reason to rely on 
the driver CD that came with your motherboard since it’s likely 
out of date. Go to your motherboard vendor’s site and download 
the latest drivers and applications for your board. The NIC driver 
is most critical. It’s unlikely Windows XP will have native NIC 
support, so you’ll need the driver. Microsoft  Vista could have 
support for it, but many newer chipset NICs are not supported, 
so download the version you need. You should also download 
the most recent drivers for your videocard and any other add-in 
cards you have in your PC.

While you’re online, download the latest Service Pack for 
the OS you’re installing. If you have a Windows Vista disc with 
SP1 already integrated, don’t worry about it. If not, download 
it at http://tinyurl.com/5w44a9. For Windows XP, you’ll want 
to download the network installation package of the Service 
Pack (http://tinyurl.com/5ofnk8). It’s designed to be installed on 
multiple computers, but it will also let you install the Service Pack 
without having to connect to the Internet. You can put all the 
drivers and the Service Pack in a folder on the hard drive you’ll be 
replacing or save them to a USB key.

SAY YOUR GOODBYES
OK, you’ve got your keys and apps, your drivers and Service 
Pack. It’s time to leave behind your previous install. Completely 
power down your machine by unplugging it or switching it off  

It’s very important that you deactivate some applications, such as Adobe’s Photoshop CS3, before 
you take down your old drive or you may have problems reinstalling it.

Backing up your Steam games with the app’s built-in utility will save 
you a lot of downloading later on. Alternatively, you can copy the 
entire Steam directory over from your old drive to your new one.

clean start
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at the PSU. Open your PC and install your new hard drive in an 
empty bay and plug it into an open SATA port. Remember, some 
motherboards use multiple hard drive controllers. You should 
plug your drive into the ports numbered 0 to 3 (for a total of four) 
as they are usually the SATA ports native to the chipset. If you use 
a third-party controller chip, you’ll need to have the drivers for it 
on fl oppy disc for XP. Vista supports USB and optical devices for 
drivers, so you can use the CD that came with the mobo or just 
drop the drivers on a USB key.

Since we’re going to copy the fi les directly over from the old 
hard drive to the new one, we recommend that you unplug your 
old drive’s SATA and power cable for now so you don’t acciden-
tally reinstall Windows over your critical data. Once you’ve done 
this, boot the machine and put the OS disc in the optical drive. 
The optical drive is usually fi rst in the boot order, but if it isn’t, go 
into the BIOS and set it as the fi rst boot device. Some boards let 
you temporarily alter the boot order by hitting F10, F11, or F12 

during boot. If your board doesn’t, you’ll have to go into the BIOS 
by hitting DEL or F2 during boot and change the boot order so 
that your optical drive is fi rst. Finally, disconnect your computer 
from the Internet. 

READY, STEADY, GO!
Let’s start with Vista: Hit the space bar during boot and begin 
installing Windows. Installing Windows Vista is very straightfor-
ward. Just enter Windows Setup, enter your product key, select 
the version of Windows you bought, and hit Next. Accept the 
terms of the license and continue until Vista asks you what kind 
of install you want. 

Since the new drive is empty, you’ll be off ered the Custom 
option to install a clean copy of Windows (Upgrade appears only 
on a drive with an OS on it). Aft er you click Custom (Advanced) 
you’ll be asked what drive you want to install Windows to. If 
you’re presented with drive letters you can’t account for (your 
single, new drive should be a single Disk 0), the OS is likely 
recognizing a multiformat memory-card reader as multiple hard 
drives. Vista does not have issues with this, but Windows XP will 
sometimes install the OS as the F: drive because of a multiformat 
card reader. Having Windows XP default as anything but C: 
causes all kinds of problems and we generally don’t recommend 
it. There is a way to fi x it, but it’s not pleasant. If this happens, 
power down, disconnect your card reader, and restart.

Aft er selecting your hard drive, click Next to continue with a 
standard single-partition install. For most people, a single parti-
tion on the drive is fi ne. If you like to separate partitions for data 
and apps, select your main drive and click New. Enter the size of 
the partition you want, click Apply, and continue on with Next.

 If you’re running a RAID confi guration in Vista or need to 
install special drivers for your controller card, hitting Load Driver 
will allow you to install the drivers from a fl oppy, CD, or USB 
key. Aft er you’ve pointed the installer at the correct drive, Vista 
will scan it and present a list of available driver options. Select 
the driver you need and click Next. Vista will now install the OS 
to your drive in 30 to 60 minutes. When you come back to the 
desktop, you’ll be asked to enter a user name and password. The 
only decisions you’ll make from this point on are the name of 

Most people will be suited by using one single contiguous parti-
tion for the OS, so just click next and Vista will format the drive 
that way.

Complain about Vista all you want, but the installation process is 
exceedingly easy. After launching Setup from the DVD, you can be 
on the desktop in as few as seven steps.

Loading third-party drivers for RAID, SCSI, or other controllers is a snap in Vista and 
you can fi nally do it from a USB key! 

clean start
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the PC, the desktop background, the Windows update settings 
(Recommended Settings is right for most people), and the loca-
tion setting for the Network: for home, select Home, if you’re at 
work, select Work.

A RAID confi g on XP is a diff erent story. If you want to 
install RAID, AHCI, SCSI, or any third-party controller drivers, 
they can be installed only from a fl oppy drive, and many XP 
discs will not support newer USB fl oppy drives. Even more 
inane, to install the drivers, you’ll need to punch the F6 key 
within a three-second window just aft er the installer has 
started. It’s like Dragon’s Lair but without the fun; miss the F6-
key window and you’ll have to reboot and try it again until you 
hit it just right.

If you have timed it right, you’ll see a screen that tells you 
that the OS cannot determine the type of mass storage control-
ler. Put your fl oppy with the drivers in, hit the S key, and select 
the device driver you need. XP will continue to ask you if you 
need to install additional drivers, but if you’re done, just hit the 
Enter key.

The installer will present you with what drive you want 
to install the OS on. Unless you need to create multiple parti-
tions, just hit Enter. Windows XP will now give you a choice 
of a quick format or a full format. The rule of thumb is to do 
a full format on new drives since the OS will map out any 
bad sectors on the disc. Quick formats should be done only 
on drives known to be good. However, a full format on a 
1.5TB drive will take hours to run. If you don’t like to be told 
the odds, do a quick format and then perform a chkdsk /r as 
soon as you have some spare time. Once the format is com-
plete, XP will begin the install. At some inconvenient point, 
XP will ask you to customize your region settings, enter a 
user name and password, enter your product key, name the 
PC, and set the time. You’d think that would be all it needs, 
but aft er 20 minutes or so, XP will halt the install and ask you 
for network settings (select Typical Settings and click Next) 
and any work group or domain settings (enter these later or 
just accept the default and move on; you can change these 
later). Now XP will make you wait another 10 or 15 minutes 
while it fi nishes. This stop and go can mostly be avoided by 
building an automated slipstream disc using nLite (http://
tinyurl.com/6d7aed), but honestly, unless you install the OS 
a lot, it’s faster to just deal with the prompts.

INSTALL SERVICE PACKS
You disconnected your PC from the network, right? This is just an 
optional precaution for Vista, as its fi rewall is on by default. But, it 
doesn’t hurt to be extra careful, so until you have the latest Service 
Pack installed, don’t connect your rig to the net. Windows XP is far 
more vulnerable because non–Service Pack builds don’t have the 
fi rewall on and connecting the machine directly to the Internet 
will infect a new install almost instantly. We know of people who 
got caught in an infi nite loop of getting infected and not knowing 
how it happened since each instance was a “clean” install from 
a factory Windows XP disc. Even if you’re on the other side of a 
router, there’s no guarantee that your PC won’t be infected by a 
machine inside the network, so disconnect that XP box.

Once the machine is running, power down and plug your old 
hard drive back in and boot into the BIOS. Make sure your BIOS 
is set to boot from your new drive, not your old drive. Now boot 

into the OS. Find the old drive (it will have a letter other than 
C:) and install the Service Pack you downloaded. For Windows 
Vista, Service Pack 1 is the current version. For Windows XP, it’s 
Service Pack 3.

MOVE IN
The fi rst driver you install should be the chipset driver. Next, 
reboot and install the audio drivers, NIC, SATA, and any other 
devices your board has. Some of the drivers will require a reboot 
and should prompt you if they do. Once those are done, move on 
to your other devices, such as the graphics card, add-in sound-
card, and TV tuner. Now connect the machine to the Internet and 
run Windows Update. You might also need to activate Windows. 
If Microsoft ’s server doesn’t accept the activation, be prepared to 
do a phone activation. Now, install the applications you gathered 
up earlier and do any OS tweaks, such as setting the standby 
mode, installing your favorite screensaver, changing the desktop 
background, and arranging the icons just so. 

MIGRATE YOUR DATA
Now it’s time to move all your data over to the new drive. 
Open My Computer, fi nd your old drive and start copying 
your fi les over. In Windows Vista, the bulk of your user fi les 
are located in C:\Users\your user name. Since your new drive 

Blink and you may miss the F6 prompt during Windows XP’s 
install for third-party drivers such as RAID, AHCI, or SCSI.

If you are installing Windows XP on a new disk, we recommend 
that you perform a full format that maps out the bad sectors on 
the hard drive. If you skip this, you can perform a chkdsk/r at a 
later point.

clean start
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is so deliciously huge, you can copy the contents of the direc-is so deliciously huge, you can copy the contents of the direc-is so deliciously huge, you can copy the contents of the direc-
tory over to your desktop. This will let you go through the 
folders and conduct a spring cleaning to weed out, say, that 
10GB of blurry photos. One thing you can instantly do is move 10GB of blurry photos. One thing you can instantly do is move 
your iTunes directory over, aft er fi rst installing iTunes on the 
new hard drive. 

Windows XP users can fi nd their iTunes folder on the old Windows XP users can fi nd their iTunes folder on the old 
drive by looking in C: \Documents and Settings\your user 
name\My Documents\My Music\iTunes; Vista users can look \My Documents\My Music\iTunes; Vista users can look 
in \Users\your user name\Music\iTunes\. Copy the contents 
from there to the same place on the new drive.

For Steam games, download the latest version of Steam 
and install it. In Vista x64, copy over the Steam Apps directory 
from \Program Files (x86)\Steam\ to the same directory on 
your clean drive. Relaunch Steam and your games will be 
ready to play. Windows XP and 32-bit Vista users will fi nd the 
fi les in \Program Files\Steam\.

CONSIDER YOUR IMAGE
Once you have your OS installed, patched, and tweaked just the 
way you like it, you should make an image of it. A disk image of 
your pristine OS allows you to instantly have a custom reinstall 
up and running should you experience a catastrophic malware 
attack or hard disk failure. We like Acronis True Image Home 
2009 ($50, www.acronis.com).

If you haven’t used disk imaging soft ware in a while, you’ll 
notice that it’s changed quite a bit. Disk imaging used to be 

run only on occasion to create a static image that when used 
would take your machine back to the very day the image was 
built. While it would save you the time of dealing with an OS 
reinstall from scratch, you would have essentially lost months 
of changes. Today’s disk imaging applications not only build 
an initial static image, but also update the image, so you could, 
say, restore the PC to the state it was two weeks before the drive 
went kaput. The apps also now support fi le backups, so you 
have two layers of safety: fi rst, a full image that is updated on a 

monthly or biweekly basis. File backups can be done weekly or 
daily depending on your level of paranoia.

SET UP YOUR SAFETY NET
You’re no longer at risk of simply losing your old schoolwork 
when your hard drive craps out. Today, a hard drive failure will 
wipe out gigabytes of invaluable memories and entertainment. 
While an external RAID 5 NAS backup drive would provide 
peace of mind, that’s a silly-expensive solution and rather slow. 
And even pairing a backup drive with your primary drive in 
RAID 1 isn’t the best solution. We like to use a single backup 
drive equal or near-equal in size to our primary drive along drive equal or near-equal in size to our primary drive along drive equal or near-equal in size to our primary drive along 
with a disk imaging app—in this case, Acronis True Image. We with a disk imaging app—in this case, Acronis True Image. We 
set the disk imaging app to make a weekly image backup of our set the disk imaging app to make a weekly image backup of our 
primary drive and fi le backups every other day. We like this primary drive and fi le backups every other day. We like this 
confi guration because it gives us some fallback that a RAID 1 confi guration because it gives us some fallback that a RAID 1 
array doesn’t. If you erase something on RAID 1 and realize you array doesn’t. If you erase something on RAID 1 and realize you 
need it the next week, it’s gone. Or if a virus runs amok on your need it the next week, it’s gone. Or if a virus runs amok on your 
primary drive, it does so simultaneously on its RAID 1 counter-primary drive, it does so simultaneously on its RAID 1 counter-
part. With a disk image and regular backups, you can choose part. With a disk image and regular backups, you can choose 
from multiple points in time to recover.from multiple points in time to recover.

So power down your machine, disconnect your old drive, 
and put it in a safe place. Install the second new drive, plug it into and put it in a safe place. Install the second new drive, plug it into 
the port the old drive was in, and power up. Right-click My Com-the port the old drive was in, and power up. Right-click My Com-
puter, click Manage, select Storage, and Windows should ask you puter, click Manage, select Storage, and Windows should ask you 
to initialize the new disk. Create a partition on the drive and for-to initialize the new disk. Create a partition on the drive and for-
mat it. Again, unless you have a need for separate partitions, one mat it. Again, unless you have a need for separate partitions, one 
single contiguous partition mitigates the drive letter confusion.single contiguous partition mitigates the drive letter confusion.

SCHEDULE YOUR BACKUPS 
Install True Image Home 2009. (Note: Although Acronis True Im-
age Home 2009 works with RAID, it doesn’t work with all RAID 
confi gurations. Acronis’s True Image Echo Workstation is a better 
choice for RAID imaging, albeit more expensive.) Launch the 
program, click Back Up, and select My Computer. Select the C: 
drive for backup. Click Next and select your target for the archive. 
Choose the second drive, create a new folder by clicking Create 
New Folder, name the fi le, and click OK. In the Scheduling pane, 
select a backup schedule that works for you—one that doesn’t run 
during the times you use your PC. Enter a user name and pass-
word so Acronis can run the backup unattended. Under Backup 

Acronis True Image 2009 is fairly easy to use and lets you make 
complete images and fi le backups, including specialized backups 
of email, the registry, and application settings.

You can set Acronis True Image Home 2009 to make a monthly 
image of your machine so a restore won’t take you back to day one. 
You can also tell the program to back up your application data and 
documents on a daily basis.

clean start
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Method, select Incremental. Hit Next for the next four tabs and 
your hard drive will be backed up on the specifi ed schedule. 

You should also create a separate image that you keep handy 
if you do need to roll your machine back to day one status. To do 
this, go to the opening menu of True Image, select Backup and 
Restore and My Computer, select your C: drive, and click Next. 
Select Target archive and put the image in a directory on your 
second drive. Name the fi le Day1.tib. Select Schedule and make 
sure it is set to Do Not Schedule. The window should say “Run 
this task manually.” Click Summary and then Proceed. 

You should also now set True Image to make automatic 
backups of your data. Aft er you select Backup and Restore, 
select the My Data option. This will let you select the type of 

data you want to back up and the frequency of the backups. 
You can run it daily or every other day since the process 
should be much faster once you’ve made the initial backup. 

And before you fi nish with Acronis, you should create 
a boot disk, which, in the event that your drive or OS goes 
kaput, will allow you to boot the machine in order to access 
the restore image from your backup drive. Do this by clicking 
Start > Programs > Acronis True Image Home > Bootable 
Rescue Media Builder. Select Acronis True Image Home, click 
Next, and Next again, and select CD-RW. Pop a blank disc in 
the optical drive and your boot disc will be created.

Congrats. You’re done and fully prepared for just about any 
type of catastrophe. 

So the worst case scenario happens: Your 
hard drive dies or you try a Windows 
“performance” trick and accidently nuke ev-
erything on your drive. Not a problem. Grab 
the True Image Home 2009 rescue disc that 
you made and drop it into the optical drive. 
Boot the machine off of the disc. Select 
Acronis True Home 2009 and click Manage 
and Restore. Locate the image that you want 
to restore from your secondary hard drive. 
If you want the last automated image True 
Image Home made, select that. If you decide 
you want to go back to your day one image, 
point it at that directory.

Select Restore Whole Disks and Partitions 
and then select the disk you want to restore 
from the backup image. Since you had only 
one partition on your original drive, you 
should be presented with only the C: drive 
and the MBR and Track 0. Select both. Now 
select the destination drive where you want 
the partition to go. If the target drive still has a 
partition on it (whether infected or corrupted) 
you’ll get a warning message saying so. Just 
click OK. Click Next until you get to the Sum-
mary screen and click Proceed. True Image 
will proceed with the image restoration and 
you should be able to boot directly into the OS 
as it was last backed up. 

Restoring your image is as easy as popping in the boot CD, selecting the image you 
want to restore, and waiting for your system to come back to life.

Make sure that you select the correct disk that you want to restore your image to.

Restoration Software
Putting your defensive strategy to work



We present the most intriguing tech 
products, people, and news of 2008

Years from now, when future geeks muse over the history 

of PC tech, what will they remember about 2008? That’s the 

question we sought to answer when we compiled this com-

prehensive technology retrospective of the last year. Make no 

mistake, identifying and sorting the year’s most signifi cant 

tech events was no easy task. We locked ourselves in a room 

where we mentally relived the last 12 months, pondering 

hundreds of items of note and debating the importance of 

each to fi nd its appropriate rank on our list. Behold the result: 

our countdown of 100 items representing the most notewor-

thy events and product releases that shaped the PC computing 

landscape in 2008. Of course, there are more than just 100 

things about this past year worth mentioning. Find our com-

plete list of 250 entries online at http://tinyurl.com/mpc250.
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100  FREE FULL- 

  FEATURED GAMES 
Quake Live and Battlefi eld Heroes 
betas prove that free games are 
worth your time. 

99 ASUS STRIKER II 
EXTREME Fast and 

boldly diff erent from the 790i 
reference design, the Striker II 
Extreme will likely mark the 
zenith of Nvidia’s chipsets.

98 KINDLE MAKES A 
KILLING, ENCORE 

TO FOLLOW An estimated 
240,000-plus Kindle sales 
can’t be ignored; thus, Ama-
zon hatches plans to release a 
follow-up e-reader.

97 WAL-MART WAVES 
GOODBYE TO LINUX 

Lackluster demand forces Wal-
Mart to end its four-month, 
600-store trial of selling $199 
Linux-based Evermax computers 
(online sales remain).

96 HARDCORE’S REACTOR 
Oil-immersion computing 

goes mainstream with the release 
of the Hardcore Reactor PC.

95 OPENOFFICE 3.0 
LAUNCHES WITH 

IMPROVED DOC SUPPORT
The open-source productivity suite 
steps up its game by implementing 
fi lters for Microsoft ’s XML format, 
allowing for easy importing of 
Offi  ce 2007’s .docx files.     

94 SKULLTRAIL 
TRAILBLAZES Intel’s 

insane, over-the-top Skulltrail plat-
form gives consumers the ability 
to have their very own dual-proc, 
eight-core monster.

93 ICANN VOTES TO 
ALLOW CUSTOM 

TOP-LEVEL DOMAINS Follow-
ing a weeklong meeting in Paris, 
ICANN, the Internet’s nonprofi t 
overseer, loosens its grip on generic 
top-level domain names.

92 JOHN CARMACK 
DEEMS DIRECTX 11 

UNNECESSARY  In a sit-down 
with us at E3, Carmack admits 
he doesn’t see a need for either 
DirectX 10 or 11, given the ma-
turity of the DirectX 9 API and 
the prominence of compatible 
hardware.

91 HYBRID GRAPHICS HOP 
ONTO DESKTOPS

Rivals ATI and Nvidia both release 
hybrid graphics solutions enabling 
users to combine integrated graph-
ics with discrete graphics cards.

90 KODAK DEVELOPS 
50MP SENSOR

Kodak’s new fl agship CCD sensor 
capable of 51.6 million square 
pixels promptly gives every 
other digital camera on the market 
megapixel envy.

89 AT&T FIRST TO SHOVE 
MICROSOFT’S SURFACE 

INTO RETAIL STORES AS A 
SHOPPING TOOL Microsoft ’s scin-
tillating Surface technology makes 
its retail debut in select AT&T 
stores and steals the show from 
the mobile devices it’s intended to 
help sell.

88 NVIDIA ACTIVATES 
PHYSX AND CUDA

87 JURY HELPS RAMBUS 
STICK IT TO MEMORY 

INDUSTRY A jury rules that 
Rambus did not commit fraud 

or engage in anticom-
petitive practices when 
obtaining its patents for 
memory technology.

86 AIRLINES TAKE 
WI-FI ABOVE 

THE CLOUDS Gogo pro-
vides passengers with 
the ability to take their forum 
disputes to the skies by incorpo-
rating wireless Internet access 
on select flights.

85 MICROSOFT SPENDS 
$300 MILLION ON 

GRASSROOTS “I’M A PC” 
CAMPAIGN 

84 ADOBE AIR VS. MICRO-
SOFT SILVERLIGHT

With rich Internet applications 
gaining ground, Adobe’s AIR 
sets the stage for a long-term 
showdown with Microsoft’s Sil-
verlight API, despite each one’s 
different approach (runtime vs. 
browser plugin).

83 LORD BRITISH 
LAUNCHES INTO SPACE 

Most know Richard Garriott as 
the creator of Ultima, but on 
October 13, 2008, Garriott, aka 
Lord British, leaves videogames 
behind for new adventures in 
outer space.

82 AMD RELEASES 
PHENOM, RIGHT INTO 

THE BARGAIN BIN Following 
Phenom’s unspectacular debut, 
AMD finds itself in the famil-
iar position of battling for the 
bang/buck crowd.

81 CRYTEK CEO 
ESTIMATES PIRACY 

RATE AS HIGH AS 20:1
Piracy continues to plague PC 
sales, but during an interview, 
Crytek CEO Cevat Yerli puts a 
number on the problem, claim-
ing that 15 to 20 PC games are 
pirated for every one that is sold.

80 SPORE GOES GOLD 
Will Wright’s magnum 

opus arrives in stores, making 
demigods of gamers everywhere.

79 AMAZON ENABLES 
CELL PHONE 

SHOPPING WITH TEXTBUYIT

78 GOOGLE DRESSES UP 
GMAIL WITH GOGGLES, 

EMOTICONS, AND THEMES 
Gmail, while still—and perhaps 
forever—in beta form, receives 
several delightful new features.

77 COMPUTING TAKES 
COVER IN THE CLOUD

The concept of cloud comput-
ing draws increased interest 
from heavy hitters in the tech 
industry, including IBM, which 
invests $300 million to upgrade 
its infrastructure to off er cloud-
based services.

76 SEAGATE BARRACUDA 
7200.11 1.5TB HDD 

A decently fast, stupid-huge 
7,200rpm hard drive for less than 
$200? Sign us up!

75 REALNETWORKS 
RELEASES, THEN 

SUED OVER DVD COPYING APP 
What happens if you release DVD 
copying soft ware capable of copy-
ing DVDs without circumventing 
the CSS encryption? You go to 
court anyway.

74 TORRENTSPY SAYS 
GOODBYE, THEN 

ORDERED TO PAY $110 MILLION 
IN DAMAGES TorrentSpy 
becomes a self-proclaimed mar-
tyr when it shuts down rather 
than log user data. 

92
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73 THE PIRATE BAY GROWS 

TO 10 MILLION USERS 
Much to the dismay of the RIAA 
and MPAA, the Pirate Bay’s explo-
sive growth yields 10 million peers 
managing one million torrents.

72 THERMALTAKE 
DUO ORB Our favorite 

CPU air cooler eschews the high-
rise trend and still outperforms the 
competition.

71 APPLE BUNDLES 
A LOAD OF CRAPWARE 

WITH ITUNES Apple enters the 
bundled crapware racket by 
foisting first Safari and then 
MobileMe on unsuspecting 
Windows owners using Apple’s 
software update utility, which is 
included with iTunes.

70 CENTRINO 2 CRUISES 
ONTO LAPTOPS

Intel’s long-awaited Centrino 2 
platform lands on laptops, bring-
ing with it several improvements 
in both performance and power 
management.

69 WINDOWS XP SP3 
ARRIVES AFTER 

ROCKY START XP owners are able 
to download the OS’s third Service 
Pack, but not before a compatibility 
issue forces Microsoft  to temporar-
ily pull SP3 from the web.

68 PC GAMING ALLIANCE: 
WHOOP-DE-DO 

The death of PC gaming continues 
to be exaggerated, but should the 
threat become imminent, the PC 
Gaming Alliance will be there to do 
nothing about it.

67 CREATIVE GETS 
CRANKY WITH 

X-FI/AUDIGY DRIVER 
MODDER DANIEL_K Daniel 
Kawakami’s modifi ed X-Fi and 
Audigy drivers, which fi x several 
issues in Vista, are heralded by 
all except Creative, which pub-
licly chastises the programmer in 
a letter on the company’s forum.

66 CANON LAUNCHES EOS 
5D MARK II DSLR Even 

without the ability to shoot HD 
video, Canon’s new DSLR kicks 
all kinds of ass, starting with a 
full-frame 21.1-megapixel 14-bit 
CMOS sensor. 

65 WESTERN DIGITAL 
VELOCIRAPTOR

With no 10,000rpm challengers 
in sight, Western Digital pum-
mels its own flagship Raptor line 
by launching the Velociraptor, 
a speed successor wrapped in a 
black heatsink.

64 COOLIT FREEZONE 
ELITE The Freezone 

Elite thermoelectric CPU cooler 
strikes a mostly elegant balance 
between cooling prowess and 
size.

63 INTEL QUAD-CORE 
PROCESSORS DROP 

BELOW $200

62 CREATIVE CREATES 
WORKING X-FI 

DRIVERS FOR VISTA USERS
Late to the party, sure, but 
aft er waiting nearly two years, 
Creative throws Vista owners a 

bone with X-Fi drivers re-estab-
lishing Dolby Digital and DTS 
decoding.

61 SUPREME COURT 
UPHOLDS FIRST 

FELONY SPAM CONVICTION 
Not surprisingly, free speech 
doesn’t include using fake email 
addresses to sell scam products. 
What is surprising is the close 
4-3 vote denying spammer 
Jeremy Jaynes’s appeal.

60 SEVERED UNDERSEA 
CABLES GIVE RISE TO 

CONSPIRACY THEORIES 
The culprit in a rash of ruptured 

telecommunications cables in 
the Arabian Sea? Abandoned 
anchors dragged by inclement 
weather. 

59 INTEL X25-M SSD 
This notebook-size 80GB 

drive essentially gives you RAID 0 
performance in a single drive.

58 MICROSOFT MASKS 
VISTA AS A NEW OS 

IN MOJAVE EXPERIMENT 
Apparently, Vista’s problem is 
one of perception, or so Micro-
soft tries to prove by disguising 
it as a new OS called Mojave and 
then demoing it to 140 people 
with no prior Vista experience.

57 PENRYN: HONEY, I 
SHRANK THE CPU

Intel’s biggest Core i7 competi-
tor doesn’t come from AMD—it 
comes from Intel’s own older, 
wildly successful 45nm-based 

Penryn family of CPUs.

56 UBUNTU 8.04 HARDY 
HERON ARRIVES 

While both Apple and Microsoft  
struggle with their operating 
systems, the open-source wunder-
kinds at Ubuntu release the best 
version of Linux yet.

55 GROWING TREND IN 
GREEN COMPUTING

Energy efficiency moves to the 
forefront of the IT industry, ig-
niting a mass movement among 
manufactures of everything 
from green hard drives to green 
wireless routers.

54 ADOBE CS4 ARRIVES 
WITH GPU SUPPORT

In the “Why the frak didn’t 
someone do this earlier?” 
department, Adobe’s Photoshop 
CS4 lets you use the GPU to 
enable smooth-as-butter zooms 
and rotates in photo editing.

53 LARGE HADRON 
COLLIDER GOES LIVE 

AND WORLD SURVIVES Having 
already dodged a bullet in the 
Y2K scare, the human race once 
again cheats death when physi-
cists switch on the LHC without 
destroying the universe.

52 OPENING CEREMONIES 
KICK OFF WITH GIANT 

BSOD AT BEIJING OLYMPICS 
As Li Ning, one of China’s sport-
ing greats, dangles in midair 
preparing to light the cauldron, 
behind him onlookers catch a 
glimpse of an Olympic-size blue 
screen of death.

51 EU SLAPS MICROSOFT 
WITH RECORD $1.3 

BILLION FINE European Union 
regulators call Microsoft out 
on its penchant for straddling 
the line between healthy com-
petition and unfair business 
practices with the largest fine 
ever imposed on an individual 
company.

59 
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50 ATI RADEON 4870 X2 
With two R700s packed in 

a single board and a whopping 2GB 
of GDDR5 memory, this is the fast-
est videocard we’ve ever tested.

49 GOOGLE JUMPS INTO 
THE BROWSER BATTLE 

WITH CHROME Looking to shake 
things up in what has tradition-
ally been a stale two-man fight 
between Microsoft and Mozilla, 
Google bursts into the browser 
scene with Chrome.

48 LENOVO THINKPAD 
X300 With a 1.2GHz 

Core 2 Duo, this is the ultimate 
road-warrior rig for anyone who 
values substance over style.

47 EVERYONE DISCOVERS 
TWITTER (EVEN SHAQ!) 

According to the latest Nielsen 
Online statistics, Twitter’s year-on-
year growth reaches 343 percent, 
making it the fastest-growing 
social-networking site.

46 AMD AND NVIDIA SUED 
FOR PRICE FIXING 

A class-action lawsuit accuses 
rival graphics-chip makers AMD 
and Nvidia of conspiring to fix 
prices of their respective GPUs 
and videocards.

45 MICROSOFT TAKES 
OFFICE ONLINE WITH 

OFFICE LIVE WORKSPACE
Microsoft’s Office Live Work-
space boasts hundreds of thou-
sands of registered users by the 
time the software giant opens 
the beta to the public.

44 GIZMODO STAFFER 
BANNED FROM CES 

FOLLOWING TV REMOTE PRANK 

Using an infrared TV-B-Gone re-
mote, a Gizmodo cameraman plays 
a practical joke on CES exhibitors 
by turning off  fl at-screen displays 
around the show.

43 IPHONE SOFTWARE 2.0 
Apple caves to soft ware 

developers and lets users create 
and sell third-party apps with this 
major update.

42 GOV’T POLICY GIVES 
U.S. AGENTS RIGHT TO 

SEIZE AND RETAIN LAPTOPS 
The tech community is shocked 
to learn that U.S. border agents 
have been granted the power to 
confiscate documents and elec-
tronic devices for an unspecified 
time frame.

41 PROTESTORS EGG 
STEVE BALLMER

During a speech at a Hungarian 
university, the animated CEO 
is forced to take cover behind a 
desk to avoid being hit by a bar-
rage of eggs.

40 INSTANT-ON TECH 
GAINS TRACTION 

DeviceVM’s Splashtop instant-on 
soft ware fi nds its way onto several 
notebooks, allowing users to hop 
online within seconds instead of 
waiting for Windows to load.

39 JACK THOMPSON, 
OUTSPOKEN 

ANTI-VIDEOGAME LAWYER, 
PERMANENTLY DISBARRED 

38 INTEL LAUNCHES 
ATOM PROCESSOR, 

IT DOESN’T BOMB Essentially a 
dumbed-down version of Intel’s 
more powerful desktop chips, the 
company’s Atom processor is every 

bit as signifi cant and helps low-
power PCs explode in popularity.

37 NETFLIX EXPANDS 
STREAMING SERVICE 

IN A BIG WAY In an aggressive 
campaign to attract new custom-
ers, Netfl ix makes its streaming 
service compatible with several 
devices, including Microsoft ’s 
Xbox 360 console and TiVo.

36 MICROSOFT ADMITS 
THAT VISTA UAC IS 

INTENTIONALLY ANNOYING
Speaking at an RSA Conference in 
San Francisco, Microsoft  Program 
Manager David Cross tells listeners 
that Vista’s UAC was designed to 
annoy users.

35 INTEL X58 CHIPSET 
We’ve been sick of the 

hard partition between CrossFire 
and SLI motherboards for some 
time; X58 fi nally fi xes that.

34 YAHOO DODGES 
MICROSOFT’S 

TAKE-OVER ATTEMPT In an open 
letter, Steve Ballmer threatens 
Yahoo with a hostile takeover 
if it doesn’t accept Microsoft ’s 
unsolicited bid, but Microsoft ’s 
interest wanes over time.

33 MICROSOFT ANSWERS 
APPLE WITH TONGUE-

IN-CHEEK AD CAMPAIGN
Jerry Seinfeld and Bill Gates star 
in Microsoft ’s fi rst round of long-
overdue ads aimed at debunk-
ing boring PC stereotypes (and 
promoting delicious churros).

32 ACTIVISION + VIVENDI = 
ACTIVISION BLIZZARD 

Originally announced in late 
2007, the game-company merg-
er that would create Activision 
Blizzard finalizes in July 2008 
for just shy of $19 billion.

31 USB 3.0 SPEC 
COMPLETED SuperSpeed 

will deliver 5Gb/s data transfers 
when it goes live next year.

30 DDR3 IS HERE, GET 
USED TO IT  The heir to 

the RAM throne benefits from 
a perfect storm of Core i7’s 
tri-channel config, reasonable 
prices, and AMD’s DDR3 
Phenoms this year.

29 MICROSOFT EXTENDS 
XP SALES UNTIL 2010

Despite repeated attempts to kill off  
Windows XP, strong customer feed-
back convinces Microsoft  to issue a 
stay of execution until 2010.
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28 GATEWAY STUNS 

WITH AFFORDABLE 
HIGH-END GAMING NOTEBOOK
Geeks get their game on with 
Gateway’s P-7811FX notebook, a 
sub-$1,500 powerhouse that pum-
mels the competition.

27 NVIDIA RELEASES 
GT 200 SERIES For raw 

single-GPU performance, you just 
can’t beat Nvidia’s GT200 GPU, 
which powers the GeForce GTX 
260 and 280 cards.

26 LEFT 4 DEAD 
REDEFINES CO-OP 

Valve’s vision of the zombie apoc-
alypse redefi nes the cooperative 
multiplayer experience. 

25 GAMING COMMUNITY 
DECRIES SPORE’S DRM 

Electronic Arts saddles Will 
Wright’s Spore with a modifi ed 
version of SecuROM, sparking a 
backlash from angry gamers.

24 GOOGLE’S OPEN-
SOURCE ANDROID 

OS DEBUTS T-Mobile and handset-
maker HTC partner up to release 
the fi rst mobile phone built around 
Google’s Android platform.

23 INTEL MOTHERBOARDS 
FINALLY SHIP WITH SLI 

SUPPORT

22 NVIDIA SUED OVER 
BAD NOTEBOOK GPUS 

A shareholder hits Nvidia with a 
class-action lawsuit over faulty 
notebook GPUs that the graphics-
chip maker admits suff er from an 
“abnormal failure rate.”

21 SEAGATE LAUNCHES 
WORLD’S FIRST 1.5TB 

DESKTOP DRIVE Seagate’s 1.5TB 
hard drive not only off ers the most 
storage space of any desktop drive 
on the planet but also qualifi es as 
the largest capacity increase ever.

20 AMD SPLITS INTO SEPA-
RATE DESIGN AND MAN-

UFACTURING COMPANIES Tough 
times call for drastic measures, 
and for AMD, that means splitting 
into two companies so that one 
can focus entirely on chip design 
while the other takes on the more 
expensive role of manufacturing.

19 FANTASY BUFFS MOURN 
THE PASSING OF D&D 

CO-CREATOR GARY GYGAX 

18 MICROSOFT NAMES, 
DATES, AND DEMOS 

WINDOWS 7 Details regarding 
Microsoft ’s next OS, Windows 7, 
pour out of Redmond, revealing 
everything from what changes 
Vista owners should expect to 
how MS came up with the name.

17 EVERYONE GETS RICK-
ROLLED, EVEN THE 

NEW YORK METS New York Mets 
fans are forced to listen to “Never 
Gonna Give You Up” aft er various 
web communities vote to have 
the 1987 hit single played at Shea 
Stadium. Also hit: the Macy’s 
Thanksgiving Day parade

16 MICROSOFT POINTS 
FINGER AT NVIDIA FOR 

POOR PERCEPTION OF VISTA
Despite Microsoft ’s public 
ballyhooing over Vista’s sales 
numbers, consumers view the OS 
as crash prone, a perception the 
soft ware giant blames on buggy 
Nvidia drivers.

15 RIAA WINS $222,000 
JUDGMENT—THEN 

LOSES IT A jury finds Jammie 
Thomas guilty of copyright 
infringement and orders her 
to pay $222,000 in associated 
penalties before the case is later 
declared a mistrial.

14 RADIOHEAD ASKS FANS 
TO PAY WHAT THEY 

WANT FOR ALBUM

13 VERIZON WIRELESS 
WINS LION’S SHARE 

OF 700MHZ SPECTRUM Verizon 
Wireless posts the winning bid for 
the coveted 22MHz band of spec-
trum known as the C-block in the 
FCC’s 700MHz auction.

12 HULU’S LAUNCH A 
HUGE SUCCESS

Met with skepticism before its 
public launch, Hulu—an NBC 
Universal and News Corp joint 
enterprise—gets the last laugh as 
the online video service becomes 
an instant hit.

11 BILL GATES RETIRES. 
WELL, SORT OF At just 

52 years old, Bill Gates com-
pletes his transition into semi-
retirement, trading in his daily 
responsibilities for a cozy position 
as company chairman and the 
early-bird buff et.

10 COMCAST AND AT&T 
CAP BANDWIDTH

Comcast makes Internet waves by 
imposing a 250GB bandwidth cap 
on its broadband customers, fol-
lowed by AT&T’s experiments with 
limits based on the service level.

9     BLU-RAY BEATS HD DVD, 
NOBODY CARES No one 

anticipated that the high-defi nition 
format war would end as 
abruptly as it did, but as more 
and more studios jump aboard 
the Blu-ray bandwagon, Toshiba 
is left with no choice but to 
abandon the HD DVD format.

8 MOZILLA RELEASES 
FIREFOX 3 AND GRABS 

MORE MARKET SHARE 
Mere months before celebrat-
ing Firefox’s fourth birthday, 
Mozilla launches version 3.0 
of its open-source browser and 
also celebrates a record number 
of downloads.

7 EEE PC’S SMALL 
FOOTPRINT A BIG STEP 

FOR PORTABLE COMPUTING 
Technically, Asus didn’t create the 
term netbook, but it might as well 
have, as the company’s Eee PC 
becomes the face of the fad.

6 STORAGE BECOMES 
STUPID-CHEAP At roughly a 

dime per gigabyte, the Tera Era en-
ters full swing, making the recycle 
bin nearly obsolete.
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2 
ATI R700 GPU
 It’s rare that we heap hearty 
praise on a chip that’s actually 

slower than the competition, but ATI’s 
R700, which powers the Radeon 4000 
series, deserves accolades for focusing 
on effi  ciency fi rst, then performance. By 
stepping back from the power-consump-
tion brink, ATI delivers a lustworthy GPU 
that kicks ass in single- and multi-GPU 
confi gurations, without requiring a crazy 
1400W PSU. 

3 
SOLID STATE 
DRIVES STORM 
THE MAINSTREAM 

As prices for NAND memory continue to 
fall, storage manufacturers seize the situ-
ation by moving solid state drives from a 
high-priced niche category to an aff ord-
able storage alternative. Surprisingly, it’s 
OCZ and Super Talent that lead the initial 
charge with low-price off erings. The price-
to-performance ratio still keeps SSDs from 
supplanting hard drives by and large, but 
SSDs fi nd a home in low-power netbooks 
and notebooks.

 

4 
DEATH KNELL 
RINGS FOR DRM 
Aft er suff ering through years of 

music tethered to annoying DRM schemes, 
consumers (and the voice of reason) fi nally 
win out as DRM-free downloads become 
the norm and not the exception. DRM isn’t 
completely obliterated, but it becomes 
clear that the days of restricted music are 
at an end when Sony BMG, the last major 
holdout, embraces MP3s free of shackles, 
just as God intended them to be.

5 
VISTA SP1 ARRIVES 
AND FIXES A 
BROKEN OS 

Vista users fed up with slow fi le transfers and 
lackluster performance celebrate the OS’s fi rst 
Service Pack and its many fi xes. Much more 
than just a series of security plugs, SP1 off ers 
speed gains in everything from browsing net-
work fi le shares to manipulating zipped fi les, 
and so much more. Even the photo screensaver 
is snappier. For the fi rst time since its release, 
Vista isn’t all that bad.

1 
CORE I7 KILLS 
ALL OTHERS

 Born from a weekend fl ing 
between a Core 2 Quad and 

an Athlon 64, Intel’s Core i7 inherits the 
best attributes of its parents to become 
the most badass CPU on the planet. With 
an on-die memory controller, chip-to-
chip interconnect, tri-channel DDR3, 
individual core Turbo mode, instructions 
to aid supercomputing tasks, and Hyper-
Threading, the Core i7 instantly makes 
all previous desktop CPUs obsolete and 
girlie-men all at once. SSDs fi nd a home in low-power netbooks girlie-men all at once. 
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PHOTOGRAPHY BY MARK MADEO

Interstellar 
Tech 
Support

Greatest 
GeekJOBS

Space may be the fi nal frontier, but so far it’s an ex-
clusive destination reserved for only a few astronauts 
and billionaire space tourists such as game developer 
Richard Garriott. For the rest of us, the closest we’ll ever 
get to touching the stars is a visit to the local planetar-
ium. Fortunately, that experience is closer than ever to 
the real thing thanks to amazing advances in modern 
planetarium technology. Star balls and laser-based 
optical projectors seem archaic when compared to the 
fully digital projection systems that harness the muscle 
of computer clusters to render 3D images. Jon Britton, 
the senior system engineer at San Francisco’s Morrison 
Planetarium, is one of the talented people bootstrapping 
planetarium technology into the digital age. 

With a background in computer science and virtual 
systems engineering, Jon joined the staff  at the new 
California Academy of Sciences to lead the engineering 
team responsible for wiring the entire building. Not an 
easy task when the facility is a single structure housing 
dozens of complicated exhibits, including an aquarium, 
a self-contained rainforest, and one of the largest—and 
most technologically advanced—planetariums in the 
world. Jon and his team designed a system of three com-
puting clusters that each channel gigabits of visual data 
through a high-speed network to a set of six $20,000 
Projection Design projectors that combine their images 
to simulate one massive display. And as impressive as 

Jon Britton holds the key(board) 
to space travel with enough 
awesome computing power to 
simulate entire galaxies

BY NORMAN CHAN



Greatest 
GeekJOBS

AN ARCHITECTURAL MARVEL Completed 
after nearly a decade of work (and $500 
million), the Academy building is an 
achievement in both design and technol-
ogy, fusing its unique form with the heady 
exhibits housed within. The living roof, 
for example, is a 2.5 acre parkland that is 
home to 1.7 million native plants. 

HALO EFFECT A ring composed of 
thousands of LEDs encircles the base 
of the dome’s interior, providing 
ambient lighting of any desired color. 
The dome’s surface is made of special 
refl ective nanoseam panels, which 
blend together to look like one giant 
screen from a distance. 

NO PLACE LIKE DOME The Morrison Planetarium’s 90-foot-diameter dome is the most imposing structure inside the California Academy of 
Sciences. In keeping with the building’s green design, the dome’s structural frame is made of 100-percent recycled steel. Even when looking 
to the stars, the Academy is thinking about Earth. 
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the computing hardware is, what’s more remark-
able is how seamlessly this complicated setup 
works to produce a breathtaking show. 

Currently, visitors to Morrison Planetarium 
enjoy a presentation called Fragile Planet, which 
runs on one of the computing clusters using Global 
Immersion soft ware. The 25-minute show was 
written, scripted, scored, and digitally modeled 
in-house by fi lm industry veterans and lift s view-
ers out of their seats on an exploratory journey 
through our solar system and beyond. The plan-
etarium’s domed display fi lls your entire peripheral 
vision—an eff ect so encompassing that you really 
feel as though you’re soaring over the landscape of 
Mars or warping across the Milky Way. 

A second computing cluster—consisting of 
seven HP XW8600 workstations, each running a 
dual-core Xeon processor and an Nvidia Quadro 
FX5600 videocard—powers real-time Uniview 
soft ware, the platform on which presentations such 
as Fragile Planet can be scripted, pre-visualized, 
recorded, and even played back in real time with 
OpenGL, like a secret director’s cut edition of Spore. 
All the high-defi nition video is channeled through 
dual-link DVI cables into a Black Diamond DVI 



Taking The helm nested 
at the rear of the the-
ater is a dimly lit control 
room where a program 
operator can control the 
planetarium’s three visual 
presentation systems. in 
addition to a traditional, 
highly detailed star map, 
presenters can activate the 
pre-scripted Fragile Planet 
movie or dive into a fully 
interactive 3D simulation of 
the galaxy rendered in real 
time. Soaring through the 
stars doesn’t require dizzy-
ing cosmonaut training—it’s 
made easy with Xbox 360 
controls! 

BeTTer Than imaX Six DlP pro-
jectors unite to project a seamless 
3600x3600-pixel digital image onto 
the 75-foot dome. Unlike tradi-
tional planetariums, this theater 
is tilted at 30 degrees and features 
stadium seating so each member 
of the 300-person audience has an 
unobstructed view of the show. The 
screen’s concave curvature even 
gives a convincing illusion of depth 
to increase the sense of realism. 
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MIRROR, MIRROR Several of the 
projectors bounce light onto carefully 
aligned mirrors to cast their images 
on the screen. These 1920x1200 
professional-grade projectors also 
have custom-made frames attached to 
their lenses to create the appropri-
ate aspect ratio for their images to 
overlap perfectly. 

SPACE BETWEEN THE WALLS Exploring space is more than just a 
visual experience. An imposing set of monolithic subwoofers and 
an array of Meyer Sound speakers hide backstage to provide the 
thundering sound effects and Sigourney Weaver’s narration for 
the show. 

matrix, and the systems are remotely con-
trolled with a fi ber-optic-based KVM. 

But the job doesn’t just end aft er all 
the cables are connected and the com-
puters are up and running. Jon is busy at 
work with innovations like tweaking the 
soft ware to run on iPhones so program 
presenters can pilot the show on the fl y 
while fi elding questions from the audi-
ence. And for hardware upgrades, he 
is looking forward to swapping out the 
existing projectors for ones that’ll output 
in 4K resolution—that’s 4096x2160 each. 
Consider us offi  cially jealous. 

BRAINS 
OF THE 
OPERATION
Three clusters 
of seven comput-
ers each render 
and feed high-
defi nition video to 
projectors using a 
DVI matrix. 

Do you or someone you know have 
a great geek job? Drop us a line at 
comments@maximumpc.com. 



In the past year and a half, solid state 
drives have come from nowhere to take 
their place as the Next Big Thing in 

storage, especially in notebooks. The 
MacBook Air and the Asus Eee PC and OLPC 
XO-1 (One Laptop Per Child) netbooks were 
among the first consumer notebooks to 
utilize solid state drives. While SSDs are still 
most popular in netbooks, they have begun 
appearing in more mainstream notebooks 
and even high-end desktops. 

SSDs have much higher read speeds 
than traditional drives, and with no moving 
parts, they’re more durable. They’re not 
susceptible to magnetic interference or 
vibration, and they use less power and run 
much more quietly than standard magnetic 
hard drives. Best of all, they come in stan-
dard 3.5-inch and 2.5-inch formfactors with 
SATA connectors and emulate traditional 
drives, so they’re compatible with existing 
architecture. Unfortunately, they’re also 
orders of magnitude more expensive per 
megabyte, thus limiting widespread adop-
tion, at least for now. 

Although the fastest solid state drives 
use DRAM for storage (with a battery 
backup to preserve data), this White Paper 
will focus on flash-based SSDs—the variety 
most commonly found in consumer gear. 

ARCHITECTURE
As the name implies, a solid state drive’s 
first point of departure from a standard 
hard drive is that it has no moving parts. A 
mechanical hard drive uses 
a magnetic read/write head 
over rapidly spinning platters, 
like a super-high-speed record 
player, while a solid state 
drive writes data to NAND 
flash memory, similar to that 
used in other flash-based storage, such as 
memory cards and USB thumb drives. 

While magnetic hard drives are marvels 
of modern engineering, solid state drives 

are much simpler—they are composed 
of just a SATA interface, a controller that 
emulates a hard drive and allocates reads/
writes, and a collection of NAND flash 
modules that data is stored on. Since NAND 
modules don’t need to wait for a drive head 
to find the appropriate data sector on a 
moving platter to read data, their random-
access times are extremely fast, as are their 

read times. And because they’re solid state, 
they neatly sidestep many of the failure 
points of traditional drives: Vibration, dust, 
magnets, and jarring are all potentially 

damaging to the read/write head and plat-
ters in a magnetic drive, but do not affect 
flash memory.

Flash-based SSDs come in two flavors: 
single-level cell (SLC) and multilevel cell 
(MLC). SLCs store one bit of data per cell, 
while MLCs store two bits per cell. SLCs 
are faster, provide less storage, and last 
longer. MLCs are cheaper and store more 
data, thus achieving better density rates, 
but they are susceptible to higher error 
rates and slower read/write times. Most 
cheap SSDs, especially those used in 
netbooks such as the Asus Eee PC, use 
MLCs for cost reasons, while performance 
SSDs use SLCs.

For an inside look at an SSD, check out 
last month’s Autopsy. For more on NAND 
flash memory, see the October 2007 White 
Paper (http://tinyurl.com/5kke3p). 

AS MORE MANUFACTURERS
      GET INTO THE SSD GAME, 
PRICES CONTINUE TO GO DOWN.
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WHITE PAPER
R&D EXAMINING TECHNOLOGY AND PUTTING IT TO USE

They’re faster and more durable than traditional hard drives and use much less 
power. Here’s why they’re the future of personal computing —NATHAN EDWARDS

Solid State DrivesWHITE PAPERSolid State DrivesWHITE PAPER

Single Level vs. Multilevel Cells
HOW IT WORKS

 

MLC NAND stores four states per memory cell and allows two bits programmed/read per memory cell.

SLC NAND stores two states per memory cell and allows one bit programmed/read per memory cell.
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N
um

be
r 

of
 c

el
ls

N
um

be
r 

of
 c

el
ls

REFERENCE POINT

REFERENCE POINT

1

1 1 0 01 0

0

0 1

Single-level cells store one bit of data per cell; multilevel cells store two bits but are more suscep-
tible to errors.



DISADVANTAGES
Despite their many advantages over tradi-
tional hard drives, current-generation solid 
state drives have several drawbacks. Flash 
memory is still much more expensive than 
magnetic media, though as more manufac-
turers get into the SSD game, prices con-
tinue to go down. The average capacity of 
SSDs is much smaller than that of standard 
drives—the largest consumer HDDs on the 
market currently are 1.5TB; the largest SSDs 
are 256GB. Write times are still slower than 
those of top-end magnetic drives, because in 
order to write to NAND memory, the entire 
block of memory the data is being written to 
needs to be erased and rewritten. 

Finally, flash memory cells are rated 
for a finite number of read/write cycles: 
around 10,000 for MLCs and 100,000 for 
SLCs, so SSDs have a limited life span. For-
tunately, solid state drives include a wear-
leveling algorithm to distribute read/write 
cycles over the entire drive evenly. When 
a solid state drive reaches its cycle limit, it 
doesn’t crash; the drive just stops allowing 
writes and becomes read-only, so you can 
still access your data, unlike a standard 
hard drive failure. 

An SSD’s life span might sound bad, but 
take heart. No long-term studies on the life 
spans of consumer SSDs exist, but even an 
MLC drive should last at least five years 
with near-constant usage, about the average 
life span of a magnetic hard drive. Single-
level-cell SSDs should last much longer—
decades, hopefully.

THE FUTURE
In November 2008, SanDisk announced a 
system called ExtremeFFS that it claims 
will make random write speeds 100 times 
faster. It does this by keeping a number of 
small memory blocks that are marked for 
deletion actually erased. By making sure 
there are always small empty blocks to 
write to, ExtremeFFS ensures much speedier 
random writes. Since Windows makes lots 
of random writes in the course of its normal 
operation, this should increase overall sys-
tem performance. 

In the next few years, all major hard 
drive manufacturers will begin offering 
SSDs, and so will many flash-memory 
manufacturers. Drive capacity will increase 
and costs will decrease following roughly 
the same exponential pattern that standard 
storage has for years. And as the tech-
nology matures and SSDs become more 
prevalent, expect even wilder innovations. 
We wouldn’t be surprised if SSDs become 
nearly ubiquitous by 2014. 

AUTOPSY

LG GBW-H20L Blu-ray Burner
Ever wonder about the gears and levers at work beneath the hood of a
Blu-ray drive? We dismantle our favorite 6x burner, for an in-depth look.
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SUBMIT YOUR IDEA Ever wonder what the inside of a power supply looks like? 
Don’t take a chance on destroying your own rig; instead, let us do the dirty 
work. Tell us what we should crack open for a future autopsy by writing to 
comments@maximumpc.com.

SUBMIT YOUR IDEA Ever wonder what the inside of a power supply looks like? 
Don’t take a chance on destroying your own rig; instead, let us do the dirty 
work. Tell us what we should crack open for a future autopsy by writing to 

SCREW DRIVE 
Underneath the 

laser pickup 
assembly is a 

screw drive that 
causes the sen-

sor apparatus 
to travel from 

the inner to the 
outer edges of 
a spinning disc 

along two lubri-
cated rails.

LASER PICKUP 
ASSEMBLY A small 
compartment holds 
two lasers, one for 
CD/DVD reads and 

writes, the other for 
Blu-ray. For writes, 

the laser burns 
precise portions of 

the underside of 
a disc, creating a 

pattern of refl ective 
and unrefl ective 

areas that map to 
ones and zeroes. For 

reads, the beams 
are modulated to 
a lesser strength 

and simply refl ect 
a disc’s digital pat-

terns onto an optical 
sensor, which 

conveys that info 
to a processor for 

playback.
SPINDLE The disc 
sits atop a spindle 
attached directly to 
a motor that spins 
the disc at a con-
stant rate of speed, 
independent of the 
laser’s movement.

DIGITAL SIGNAL 
PROCESSOR Much 
like the CPU in a 
computer, the digital 
signal processor 
is the brains of the 
operation. It acts as 
a conduit between 
the optical drive and 
the PC, sending and 
receiving information 
as data is written to 
and read from a disc.
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R&D EXAMINING TECHNOLOGY AND PUTTING IT TO USE

HOW TO
Hearing top rock, hip-hop, country, and pop artists jam together on a tune 

may sound like a clash of genres and egos, but anything is possible when 

you don the producer’s cap  —KRIS FONG

Mash Up Your MusicHOW TOMash Up Your MusicHOW TO

MUSIC, DIGITAL FILES OR CDs

AUDACITY 1.3.6
 Free, http://audacity.sourceforge.net

 HEADPHONES OR DECENT SPEAKERS
  (Not your laptop speakers)

NCH SOFTWARE SWITCH FOR 
 WMA FILE CONVERSION
  (Optional)

 APPLE ITUNES OR OTHER CD RIPPER 
(Optional) Free, www.apple.com

SUBMIT YOUR IDEA Have a 
great idea for a How To project? 
Tell us about it by writing to 
comments@maximumpc.com.

Radiohead jamming with Kanye West would be an odd pairing on any stage, 

but in the world of mashups—where the vocals of one song are folded into 

another—the weirder the combination, the bigger the bragging rights. While 

the RIAA is determined to put an end to the art form, many artists are releasing 

a cappellas (vocal-only tracks) and stems (individual tracks of a mix) to support the 

creative movement. And you can be part of it too. 

Pros often look to Sony ACID Pro ($315, www.sonycreativesoftware.com) or 

Ableton Live ($600, www.ableton.com) to mash up music, but you can do it on 

the cheap with Audacity, an open source audio-editing app, and your own music. 

We’ll show you some basic techniques—you just need to find two tracks to work 

with. Find songs in the same key (like Chris Brown’s “Kiss Kiss” and Puddle of 

Mudd’s “Blurry”) or ones that have a similar groove and chord progression (such 

as Jet’s “Are You Gonna Be My Girl” and Iggy Pop’s “Lust for Life”). Or Google 

“a cappella download” to find vocal track downloads (for personal use only) and 

choose a song in your music collection to pair it with. We always thought 

4 Non Blondes’s “What’s Up?” sounded just like Bobby McFerrin’s “Don’t Worry, 

Be Happy,” so for simplicity’s sake we’ll use these songs for our example.

WHAT YOU NEED

TIME = 120 MIN
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FIT A PITCH
Next, you’ll need to change your 
second song’s pitch to fit with the 
first’s. Audacity’s Change Pitch pro-

cessor lets you transpose a song’s pitch/key 
without affecting its tempo. So how do you 
determine how much pitch shifting is neces-
sary? If you’re musically inclined, determine 
each key by jamming along on your guitar 
or synth. You can also try searching for sheet 
music for your songs (try www.musicnotes.
com) to find the key. Or figure it out by trial 
and error. Click the left panel of track 4 
(your secondary song) to select the entire 
track and choose Effect > Pitch and Tempo 
> Change Pitch. If you know what keys your 
songs are in, choose the appropriate ones 
from the From and To pop-up menus, select 
which direction to transpose the pitch—Up 
or Down—and click OK. If you’re winging 
it, focus on the Semitones (half-steps) field. 
Enter a positive (transpose up) or negative 
(transpose down) whole number and click 
OK; 12 semitones equals one octave, so 
try numbers from ±1 to ±11 (the larger the 
number, the bigger the pitch change—if 
your songs have too much pitch disparity, 
the vocal could sound bad). Press Play or the 
space bar to check your work; if you need to 
try again, press Control-Z to undo and then 
repeat this step.

CONVERT YOUR FILES
While Audacity plays nice with 
WAV, AIFF, MP3, and Ogg Vorbis 
files, it doesn’t do WMA (Win-

dows Media Audio), AAC (iTunes), or 
copy-protected audio file formats, so you 
may need to convert files before you start 
mashing (if not, skip to step 2). If your 
song resides on a CD, copy it to your com-
puter as a WAV or AIFF file, using iTunes 
or any other CD-ripping software. If you 
have nonprotected WMA files, NCH Soft-
ware’s Switch is a free utility that’ll con-
vert them into WAV or AIFF. Likewise, you 
can use iTunes to convert nonprotected 
or CD-ripped AAC files (M4A) into WAV 
or AIFF files. However, if you purchased 
your song through the iTunes Store, you 
can’t convert copy-protected AAC files 
(M4P)—sure, it’s easy to burn protected 
songs to a CD and then reimport them, but 
you’re not going to read about how to do 
that here. Nope. No-sir-ee Bob….

PUT TOGETHER A PROJECT
Launch Audacity, choose File > 
Import > Audio, select your main 
song file (the one that’ll serve as 

the crux of your composition; for us, it’s 
the 4 Non Blondes tune), and click Open. 
Your song will appear as two (stereo) 
audio waveforms in track 1. Next, choose 
Tracks > Add New > Stereo Track twice 
to add two blank stereo tracks (tracks 2 
and 3); these will serve as your composi-
tion palettes as you piece together your 
mashup. Finally, choose File > Import > 
Audio, select your secondary song (our 
McFerrin tune), and click Open to add 
it to track 4. Then choose File > Save 
Project. If you press Play (the green arrow 
button at the top of the window), you’ll 
basically hear a raw mashup (or more like 
a munch up) of your music. This probably 
ain’t gonna sound good; the songs may be 
in different keys, the tempos won’t match, 
and the parts you want to align are not 
going to line up from the get-go. Time to 
do some fixin’….

1 2

3

BEST OF THE BEST

Learn from the Mashup Masters
The best mashups feature contrasting genres, a few surprises, and fl awless song 
weaving. For inspiration, take a listen to mixes from these mashup masters.
Party Ben’s (www.partyben.com) “Boulevard of Broken Songs v2” (Green Day 
meets Oasis, Travis, and Aerosmith) is one of our favorites, but “Single Ladies (In 
Mayberry),” which pits Beyonce against the Andy Griffi th theme, makes us smile.

Mark Vidler (www.gohomeproductions.co.uk) is best known for his “Rapture 
Riders” mashup (Blondie vs. the Doors); we also like “Paranoid Rock” (Queen vs. 
Black Sabbath).

DJ Zebra (www.dj-zebra.com) is French, as is the copy on his website, but click 
Productions and you can check out his work, including “Suck My Kelis” (RHCP vs. 
Kelis) and “Come Closer” (the Beatles vs. NIN). 



PLACE AND PACE PARTS
To move things into the proper 
place, click Solo on track 4 to unsolo 
the track and then click Mute. With 

the Selection tool, click the area before any 
vocal snippet in track 3 and press the space 
bar to start playback from that point; listen 
to how the new vocal sits on top of your core 
song. To move the region, select the Time 
Shift tool and drag the region until it starts 
exactly where you want it. If the timing is a 
bit off, use Change Tempo on just that region 
to fine-tune it. If you want to get a little 
funky with the vocal delivery, do a little 
slice-and-slide to change up the pace; take 
a listen to the vocal and pay attention to its 
waveform peaks, which represent percus-
sive attacks (such as vocal utterances, drum 
hits, and guitar strums). Zoom in and locate 
the words and associated peaks that fall off 
the beat. Then click the wave directly before 
the peak, choose Edit > Split, select the Time 
Shift tool, and nudge the right side split a 
tad to the right to pace it later in time.

CHECK THE TIME 
Most likely, your two songs won’t 
have the same tempo, but they 
don’t need to be completely in 

time with each other—just on the parts 
you want to work with. Audacity lets you 
change a song’s tempo without affecting 
its pitch, so you won’t have to worry about 
your singer sounding like the Chipmunks… 
or Tay Zonday. With track 4 selected, 
choose Effect > Pitch and Tempo > Change 
Tempo. If you don’t know the BPM (beats 
per minute) of 
your songs (see 
the Quick Tip), 
you’ll have to 
wing it; in the 
dialog box, use 
the Percent 
Change slider 
to either slow 
down (slide left) 
or speed up 
(slide right) the 
tempo. The more 
you slide, the 
more you’ll af-
fect the timing, 
so gauge your 
songs and prepare for some trial and error. 
Click OK to make the change and check 
your work. If things don’t line up very well, 
undo your deed and try again.

SAMPLE YOUR SONG
You’ll now sample the vocal parts 
in your second song that you want 
to pair with the first song; since our 

songs share the same chord progression 
almost throughout the song, we’re going 
to alternate the vocals in the verses. Click 
the Solo button on track 4 so you hear only 
that track and then click the Zoom In tool 
repeatedly to see more waveform detail. 
Next, select the Selection tool, drag it across 
either waveform where you think your de-
sired vocal part starts and ends, and press 
the space bar to hear your guesswork. To 
get those start and end points exact, hover 
the Selection tool over the left side (start 
point) of your selection until it turns into a 
pointing finger, click and drag to the left or 
right to reset the start point, and press the 
space bar to hear your progress. Once you 
nail the exact start point, do the same to the 
right side of your selection to reset the end 
point. Then copy your selection (Control-C), 
click track 3 at the point where you want 
this sample to begin, and paste (Control-V). 
Repeat for any other desired parts.

4
5

6

R&D EXAMINING TECHNOLOGY AND PUTTING IT TO USE

QUICK TIP
There are books There are books 
for DJs that list the for DJs that list the 
BPM of thousands BPM of thousands 
of popular songs; of popular songs; 
search for “BPM search for “BPM 
List” on Google List” on Google 
Book Search 
(http://books.
google.com) to 
see if your song’s 
BPM appears in the 
generous preview.

60 | MAXIMMAXIMMA UXIMUXIM MUMU PCPCP | FEB 09 | www.maximumpc.com

DOS AND DON’TS

Tips for Budding Mixmasters
Find songs with long intros, solo breaks, or a cappella passages, as these offer  • 

 the greatest mashup opportunities.

Avoid choosing songs that vary greatly in key, as too much pitch shifting can  • 
 make vocals sound horrible.

Use EQ and volume levels to bring more clarity to the parts you want to   • 
 emphasize, tone down the stuff you don’t, and balance things together.

Don’t focus on just the vocals; you can create some interesting mixes by   • 
 layering instrumental parts together.

The age-old K.I.S.S. (Keep It Simple Stupid) rule applies—toss in too many  • 
 melody lines at once and your music will lose focus.

Experiment and have fun! There is no right or wrong way to mash up songs, as  • 
 long as it sounds good to you.
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SWITCH UP THE STRUCTURE

To prevent your sampled vocals 
from clashing with the original, 
you may want to replace sections 

of your first song with an instrumental 
version taken from a different section 
(such as an intro or instrumental break). 
First, solo track 1, use the Selection tool 
to select the section you want to replace, 
leaving a little extra behind on the start 
and end points for blending, and choose 
Edit > Split Delete to delete it (or select 
Edit > Split New to preserve the unwant-
ed selection in a new track, which you 
can use as a scrap bin). Then select the 
replacement section, taking a little extra 
beyond the start and end points for blend-
ing, and copy and paste this into track 2 
below the hole in your timeline. Unsolo 
track 1, mute tracks 3 and 4 so that only 
tracks 1 and 2 are enabled, and play back 
your work. Move the region if needed so 
that it syncs up with the song. To make the 
edit less noticeable, apply a little fade-in/
fade-out to your overlapping edit points. 
Select the end point overage in track 1 
and choose Effect > Utility > Fade Out, 
then select the start point overage in track 
2 and choose Effect > Utility > Fade In. 
Now click anywhere before the edit point 
and press the space bar to check it. Do the 
same for the ending edit, except fade in 
the track 1 restart point and fade out the 
track 2 region ending.

CLEAN UP AND BLEND PARTS
Finally, do some cleanup to reduce 
or remove any extraneous instru-
mentation in your mashed-in vocal 

parts and blend everything together. While 
it’s almost impossible to isolate a vocal 
completely from its instrumental accom-
paniment, there are things you can do. Try 
using the EQ to turn down the frequencies 
outside the vocal range—solo the track, 
select the region, choose Effect > Filter > 
Equalization, select the Graphic EQ button, 
notch down some frequency sliders, and 
click Preview to hear your progress. How-
ever, depending on the instrumentation, 
this might not be very effective. Another 
way to do this is to remove the instrumen-
tation between each vocal utterance—solo 
the track, zoom in on a region, select stuff 
between two vocalizations, choose Edit 
> Split Delete to remove it, and repeat 
as needed. To ease any abruptness in 
your edits, try using the fade-in/fade-out 
technique on your region snippets. When 
you’re satisfied with your mix, select File > 
Export to save your project as an audio file 
in your preferred format. 



RAM Timing
My roommate, with my help, 
built a brand-new PC worthy 
of mention in your maga-
zine; it has a Q6600, 4GB of 
DDR2/1066, an ATI Radeon 
4850 GPU, and a DFI P45-T2RS 
motherboard. After installing 
his student copy of Windows 
Vista x64 and some of his 
favorite programs, I advised 
him to run CPU-Z to ensure 
that the motherboard had 
set everything correctly, as I 
didn’t really want him to have 
to dive into the BIOS unneces-
sarily. CPU-Z reported that 
his RAM was cruising along at 
DDR2/800.

He has a 1,066MHz front-
side bus, so the RAM timing 
was unusual, especially since 
the board is certified for 
DDR2/1066. We checked the 
BIOS and found that we can-
not set that frequency without 
overclocking, which causes the 
machine to become unstable. 
We decided that the problem is 
the BIOS and discovered that 
DDR2/1066 is supported only in 
the latest BIOS—but DFI’s BIOS 
update utility doesn’t work with 
Vista x64! Neither of us owns 
a floppy drive anymore, so we 
thought we might try booting 
from a USB drive, but we can’t 
find any Vista 64 capable tools 
for creating that, either.

What should we do to 
update the BIOS?

—Lyle Goodwin 

You have several options. The 
first is just to let it be. Your 
friend will see minimal gains 
(and possibly even losses in 
some applications) by run-
ning the RAM at DDR2/1066 
versus DDR2/800, so he can 
avoid the headache and just 
not fiddle with it. Remember, 
motherboard vendors always 
recommend that if the board’s 
working fine, don’t mess 
with it. 

For most enthusiasts, 
though, this situation is 
an invitation to immedi-
ately update to the latest beta 
BIOS. An alternative option 
is to look at the BIOS screen 
during boot. You should see 
a prompt or option for some 
kind of built-in updating tool. 
Many current motherboards 
let you update the BIOS 
using a built-in flash utility. 
Just store the updated BIOS 
file on a USB key (the key 
must be in before booting the 
machine), boot the PC, start 
the utility, and point it toward 
the USB key. A third option 
is to use Hewlett-Packard’s 
free utility that lets you cre-
ate a bootable USB key. The 
Doctor would provide a link, 
but HP’s website seems to 
shuffle the URL around on 
a regular basis. Instead, go 
to www.hp.com and search 
for “cp006049.exe.” A final 
option is to keep an $8 floppy 
drive in your tool kit.

Alien? Where?
I have an Alienware Area-
51 m7700 laptop computer 
with 2GB of memory and an 
Nvidia GeForce 6800 Go with 
256MB GDDR memory. It’s 
three years old and runs fine, 
but I would like to upgrade 
the graphics to get better 
video response. I play World 
of Warcraft and occasionally 
have problems with the video 
becoming a bit choppy. Plus, 
with the economy in its cur-
rent poor state, I don’t really 
want to buy a new computer 
anytime soon, so upgrading 
my current computer seems 
like a good, relatively inex-

pensive way to go. The prob-
lem is, when I talked to a tech 
support person at Alienware, 
I was told a video upgrade 
isn’t available for my com-
puter because the current 
videocards work with only 
the current bus configura-
tions, not with my computer’s 
bus. Is there truly no way to 
upgrade my laptop’s video?

—Thomas Oglesby

The tech support guy is right, 
Thomas. Each new mobile 
GPU typically runs hotter 
and requires more power 
than the previous iterations, 
and there’s no universal 
laptop graphics hardware 
spec. You’ve already got the 
best videocard you can put 
in your rig. You can increase 
performance relatively inex-
pensively by upping your 

This month the Doctor tackles...

RAM IssuesMigrating RAIDMigrating RAIDRAM IssuesMigrating RAIDRAM Issues

Sticky Keys         

Every notebook 
manufacturer has 
different graphics-
card specs; this 
GeForce Go 6800 
from an Alienware 
m7700 fi ts in just a 
handful of laptops.

DOCTOR IMPROVING YOUR PC EXPERIENCE ONE STEP AT A TIME
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To use 1,600MHz DDR3 like this in an EVGA 790i SLI 
motherboard, you’ll need to step down the speed to 
1,333MHz, at least initially

SUBMIT YOUR QUESTION Are flames shooting out of the back of your rig? First, 
grab a fire extinguisher and douse the flames. Once the pyrotechnic display has 
fizzled, email the doctor at doctor@maximumpc.com for advice on how to solve your 
technological woes.



RAM to 4GB—you can get 1GB 
and 2GB SO-DIMMs for your 
machine for nearly nothing, 
and that’ll help with your 
game performance—but since 
the m7700 runs on a 32-bit 
Pentium 4 processor, you 
won’t be able to utilize the full 
4GB. Other than that, you’re 
out of luck. 

Migrating RAID
A few months ago, my 5-year-
old Alienware Area 51 died. I 
narrowed my problem down 
to the motherboard. Since this 
computer is so old, I decided to 

replace it with a new, updated 
computer. The busted rig had 
two 200GB hard drives on a 
3ware RAID controller (RAID 
0 configuration). Is it possible 
to install the RAID controller 
and drives (as is) on my new 
computer as a secondary drive 
and retrieve the existing data, 
or will I have to rebuild my 
RAID during installation?

—David Truan

The Doctor strongly advises 
keeping regular backups of 
RAID 0 configs, especially if you 
plan on migrating your data. 
In fact, when possible, back 
up your data and re-create the 
array from scratch on the new 
machine, then move your data 
back to it. 

That said, we know it’s 
not always possible to back 
up before a move, especially 
in cases like this, which are 
essentially rescue missions. 
Moving a RAID array can be 
a tricky proposition, but it’s 
much easier if you use the 
same RAID controller.  The 
Doctor spoke to a 3ware tech-
support rep who said that as 
long as your new motherboard 
plays nice with the RAID con-
troller, you shouldn’t have any 

problems. Wait until your new 
computer’s fully set up and 
functional before moving your 
RAID over. Install your RAID 
controller’s drivers and then 
(with the machine powered 
down) install the RAID control-
ler with the drives attached. 
When you power on the 
computer, your array should 
show up. 

The Dirty Shift
When my computer is on, 
the Shift key seems like it’s 
being pressed repeatedly, 
even though I’m not pressing 

it. The StickyKeys feature 
keeps coming up and I can 
type only caps and symbols, 
not numbers. When I click 
an app on the desktop, it 
highlights almost all of them. 
When I click in my web 
browser, all of the screen’s 
text gets highlighted. I’m 
really not sure if this is a 
virus or a malfunction in 
the hard drive or what. The 

computer is a 3-year-old HP 
ZV6000 laptop.

—Nick Olson

It sounds like the problem is 
with your keyboard—some-
thing caught under one of your 
Shift keys might be keeping 
the contact closed. First, try 
to dislodge whatever’s under 
there with a can of compressed 
air. If that doesn’t work, pry the 
Shift keys off with a butter knife 
(carefully!) and clean under-
neath them with a damp lint-
free cloth—but make sure your 
computer is off. Then reseat 
the keys. Still no dice? The next 
step is replacing your keyboard. 
You can find one on the web for 
between $15 and $50. 

0x00000 OMG
I am becoming increasingly 
frustrated trying to fix a 
problem I’m having with a 
videocard driver (I think). My 
computer is crashing in the 
middle of games. The error 
message I get when I reboot is: 
STOP 0x000000EA THREAD_
STUCK_IN_DEVICE_DRIVER. 
I have searched forums and 
tried different things, but 
nothing seems to work except 
when I install an old videocard 
(Nvidia 6800 GS). 

 I’m running an Intel Core 2 
Quad Q6600 processor, Asus 
P5K motherboard, EVGA 8800 
GT GPU, and 4GB of RAM. 
I also have an Nvidia 9800 
GTX+, and when I installed it, 
the problem became worse.

—Gman

If it were just one videocard 
that was causing the problem, 
the Doctor would suspect 
something was wrong with 
the card itself. But since you’ve 
tried three cards and the 
problem affects only the newer 
two, the Doctor believes you’re 
suffering from either old drivers 
or a faulty power supply. We 
can’t tell from your email 
whether you’ve already tried 
updating to the latest Nvidia 
drivers, but you should reinstall 
the latest drivers whenever 
you change cards. You can find 
Nvidia drivers at (surprise!) 
www.nvidia.com. 
 If that doesn’t help, the 
problem could be your power 
supply—either it’s failing or it 
doesn’t have the juice to run 
high-powered videocards like 
the 8800 GT and 9800 GTX. 
700W should be enough. Just 
make sure to buy a name-
brand PSU; we recommend PC 
Power & Cooling. 

DOCTOR IMPROVING YOUR PC EXPERIENCE ONE STEP AT A TIME

I just read the November 2008 Doctor column, and in reply to Ben Locke’s power sup-

ply problems, I have two further suggestions based on my own recent experience.

If his board and peripherals are lighting up but the machine isn’t booting, he should 

make sure that all of the power connections to the motherboard are secure and that 

he hasn’t missed one. My Asus P5QPro needs a 24-pin connector and an 8-pin con-

nector located near the CPU. If they aren’t both connected and seated well, the board 

lights up but doesn’t boot.

Second, even with everything properly connected, my motherboard did not boot 

until I cleared the CMOS. This reset it to its default settings, and from there I was able 

to boot and get into the BIOS and reconfi gure the system.

These are two easy things to do before returning what is probably a working PSU.

—PETER MACDOUGALL

SECOND OPINION

Don’t Toss out that PSU Yet!

THE DOCTOR STRONGLY
 ADVISES KEEPING
REGULAR BACKUPS
 OF RAID 0 CONFIGS.
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REVIEWS OF THE LATEST HARDWARE AND SOFTWARE  IN THE LAB

REVIEWSREVIEWSTested. Reviewed. 
Verdictized

82   MSI  ECLIPSE SLI

84   SAPPHIRE RADEON HD 4850 X2

86   HP MEDIASMART EX487

88   SAMSUNG R610 NOTEBOOK

90   THERMALTAKE SPINQ

92   BENQ E2400 HD

93 HP MINI 1001XX

94 WD TV HD MEDIA PLAYER

96 SAMSUNG SH-S223 DVD BURNER

97 PEEK EMAIL DEVICE

99 SACRED 2

100   LAB NOTES 

      HP 8530W LAPTOP 

      CREATIVE WIRELESS RECEIVER

      ADOBE PHOTOSHOP ELEMENTS 7.0

  LOGITECH MX1100 MOUSE

  LOGITECH G13 GAMEBOARD
    

PLUS Best of the Best, 
Editors’ Blogs, and the 
No BS Podcast

INSIDE

ONLINE
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IN THE LAB REVIEWS OF THE LATEST HARDWARE AND SOFTWARE

An eclipse occurs when one celestial 
body obscures another. When MSI 
stuck its X58 motherboard with that 

moniker, we wondered just what it wanted 
to hide. Our guess is it’s the fact that the 
board supports ATI’s CrossFire X. Despite 
the Eclipse’s support for CrossFire X, MSI 
chose to change the name of the board 
at the last minute from simply Eclipse to 
Eclipse SLI. Regardless, the Eclipse SLI is 
jam-packed with features that would make 
any geek weep, including cross-platform 
GPU support, Core i7, six-slot DDR3, and 
onboard soft  X-Fi audio.

We’ve now tested three X58 boards, and 
the Eclipse SLI has an edge over its closest 
competitor, the Asus P6T Deluxe, which we 
reviewed in January, as well as the stock 
Intel DX58SO board that we used for most of 
our Core i7 testing. The Eclipse SLI is techni-
cally able to run tri-SLI. We say technically 
because though you might be able to jam a 
GTX 280 into the third slot, you’ll probably 
have to saw off  the end of the card to make 
it fi t in your case—the card has to be seated 
in the bottom slot and hangs over the mobo 
by about an inch. We tested the Eclipse with 
a pair of EVGA GTX 280 cards but were un-

able to test it in tri, as our early board 
shipped without a bridge. MSI will 
include bridges with retail boards.

Right now, it’s diffi  cult to com-
pare the performance of the three 
X58-based boards we’ve tested, as it’s 
challenging to make sure the boards 

are all set to the same 
specs. We attribute 
most of the perfor-

mance diff erences 
we’ve seen to how 

each vendor sets up the CPU, not to the per-
formance diff erences with each board. One 
thing in the Eclipse’s favor: There’s no need 
to activate the X-Fi drivers on the board, 
which is necessary on the Asus boards that 
feature host-based X-Fi drivers.

So what board would we stick our Core 
i7 in? It’s hard to say at this point, but if we 
were forced to choose, the Eclipse SLI would 
just edge out the Asus P6T Deluxe. But to 
be honest, with BIOS updates coming out 
in near real time for the new CPU and new 
chipset, the answer to that question might 
be diff erent next month. –GORDON MAH UNG

MSI Eclipse SLI
Alphabet soup heaven: Tri-SLI, i7, and X-Fi

We can hear the 
scream from Ontario: 

“It does CrossFire X 
too, damn it!”
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VERDICT

$360, www.msicomputer.com

9
Tri-SLI capable, six 
DIMM slots, and no X-Fi 
activation required.

Questionable placement 
of third x16 slot; flaky 
USB support.

STRIDER

MSI ECLIPSE SLI

BUCK

PC Mark Vantage x64 7,204 7,082

PCMark Vantage HDD 4,225 3,509

ProShow Producer (min:sec) 9:08 9:12

MainConcept Reference (min:sec) 17:58 18:00

3DMark Vantage CPU 11,257 11,239

3DMark Vantage GPU 46,410 45,424

HD Tach (MB/s) 219 185

Valve Particle test (fps) 160 155

Quake 4 (fps) 237.5 224

Everest Ultimate Copy RAM (MB/s) 19,766 19,182

Everest Ultimate Latency (ns) 32.3 31.9

Sisoft Sandra RAM Bandwidth(GB/s) 27.1 26.3

Best scores are bolded. Our test bed consists of a Core i7-965 Extreme Edition, 
EVGA GeForce GTX280 videocard, 6GB of Corsair Dominator DDR3/1600, WD 
Raptor 150 and Vista Home Premium 64-bit. Our HD Tach score was achieved using 
an Intel X25-M SSD.

BENCHMARKS
 MSI Intel
 Eclipse SLI DX58SO
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As a general rule, our belief is that pairing 
two slow-performing cards using SLI or 
CrossFire is a bad idea—you’re usually 

better off  running a single faster card. However, 
the Radeon 4850 X2 delivers astounding perfor-
mance compared to the single-GPU boards in 
its price range, spanking the Radeon 4870 and 
the GeForce GTX 280, with none of the pitfalls 
that have plagued dual-GPU boards in the past. 

At the heart of the board is a pair of ATI’s 
RV770 GPUs running at 625MHz, just like the 

single-GPU in the 4850 boards. Each GPU 
features a full complement of 800 stream 
processors, which are connected to identical 
1GB GDDR3 frame buff ers running at 993MHz 
on a 256-bit bus. Although X2 boards are 
labeled as featuring 2GB of memory, because 
the contents of each GPU’s frame buff er must 
be mirrored, applications can utilize only 1GB 
of video memory.

Like its 4870-powered predecessor, the 
4850 X2 sports ATI’s advanced video decode 

acceleration, allowing you to 
view fully accelerated picture-
in-picture Blu-ray discs. It’s fully 
compatible with multiple-monitor 
displays, and we love that this 
board features four DVI ports for 
multi-mon madness. 

In our performance testing, 
the 4850 X2 unseated the fast-
est single-GPU videocards, the 
GeForce GTX 280 and Radeon HD 
4870, in almost every bench-
mark. The exception to the rule 
was Crysis at high visual-quality 

settings and high resolution. When running 
at 1920x1200 with 4x antialiasing and the 
visual-quality settings cranked to Very High, 
we hit the 4850 X2’s memory bandwidth wall. 
Despite running at a higher clock speed than 
the 4870-family boards, the GDDR3 on the 4850 
transfers half as much data per clock cycle. 

With a street price that’s less than $300, the 
4850 X2 is a great deal for owners of lower-res-
olution 22-inch monitors. However, if you use 
a 24-inch or 30-inch panel, it’s probably worth 

ponying up for a card with a pep-
pier memory pipeline. –WILL SMITH

Sapphire Radeon HD 4850 X2
A surprisingly speedy videocard powered by ATI’s midrange GPU

This Radeon 4850 X2 board sports twice as 
many GPUs and DVI ports as its single-GPU 
brethren —and twice as much cooling! 

Best scores are bolded. Benchmarks are run on an Intel Core 2 Quad Q9770 Extreme, with 4GB 
of memory running Windows Vista. Crysis, and 3DMark Vantage are run at 1920x1200, with 4x AA 
and 8x anisotropic filtering, unless otherwise noted. Call of Duty is run at 2560x1600 with 4x AA.

BENCHMARKS
Sapphire  Radeon HD GeForce
4850 X2 4870 X2 GTX 280

Driver Version 8.12 8.12 180.48

Crysis 4X AA/Very High (fps) 12.41  29.6 18.35

Crysis No AA/Very High (fps) 27.87  31.6 22.28

Call of Duty (fps) 80.7  106.5 68.09

Far Cry 1920x1200 (fps) 60.3  68.5 52.2

Far Cry 1680x1050 (fps) 64.9  72.2 58.7

Vantage Game 1 (fps) 17.54  19.2 17.32

Vantage Game 2 (fps) 14.25  18.9 13.11

+ -

VERDICT

$330, www.sapphiretech.com

9
Killer performance 
for $300. Four DVI 
ports! Faster than a 
GTX 280. 

GDDR3 hurts memory 
bandwidth. Four DVI 
ports leave no room for 
rear exhaust vents.

EMERALDS

SAPPHIRE RADEON HD 4850 X2

AMETHYSTS



HP 
MediaSmart 
EX487
Back up every machine 
in your home and 
stream your media to 
any room 

There’s a lot to be excited about when 
you consider the features Windows 
Home Server offers out of the box—

primarily, automated backup of all your 
desktop and mobile machines and media 
streaming to every room in your house. HP 
builds on this goodness with a second-

generation WHS product that boasts both 
improved hardware and a supercharged 
features list.

When we reviewed HP’s fi rst foray into 
the world of Windows Home Server last 
year, we were optimistic about the future 
of the platform but a bit underwhelmed 
by the performance of the little box. Since 
then, the Home Server soft ware has gone 
through some teething pains, including 
a horrifi c bug that corrupted users’ fi les 
(since corrected with the fi rst Service Pack 
for the Home Server soft ware). 

To the base that Windows Home Server 
provides, HP has added a ton of powerful 
new features, including a much-improved 
media streamer; an iTunes streaming 
server; the ability to back up OS X–based 
machines using Time Machine; online back-
up for crucial fi les; integration with photo- 

sharing services, including Picasa, Flickr, 
and Facebook; and the HP Media Collector, 
which scans your client computers and 
automatically copies new photos, music, or 
videos to the Home Server. Typically, we’re 
not fans of the heavily customized shov-
elware that comes with OEM hardware, 
but in this instance, HP has added genuine 
value to the Home Server platform with 
these soft ware enhancements. The Media 
Collector is especially valuable because it 
pulls photos from our client machines to 
the server automatically—a huge benefi t, 
and one that’s not built into the core Win-
dows Home Server functionality. 

On the hardware front, the EX487 
features a beefier configuration than the 
first-gen MediaSmart. Instead of an AMD 
Turion processor, 512MB of RAM, and a 
pair of 500GB drives, the new hardware 
boasts a 2GHz single-core Intel Celeron 
paired with 2GB of RAM and a pair of 
750GB drives. There are two bays in the 
EX487 free for expansion, in addition 
to an eSATA port and four USB ports. 
Despite the beefier hardware, the machine 
remains very quiet. It was inaudible in a 
typical living room environment. 

While this isn’t enough of an advance 
to consider it a sophomore effort, it’s 
definitely spring semester of freshman 
year, and things are looking pretty good 
for Home Server. –WILL SMITH

HP’s second-gen Home 
Server looks like the 
original, but inside are 
four hot-swappable SATA 
bays, a 2GHz Celeron, and 
2GB of RAM. 
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VERDICT

$800, www.hp.com

9
Better hardware, 
corruption issues are 
fixed, and the HP add-
ons are kick ass.

We’d like a multicore 
edition to empower 
video-streaming apps 
like TVersity.

HOME ALONE

HP MEDIASMART EX487

HOME ALONE 2

Best scores are bolded. To measure home server transfer speeds, we 
copy a 1,705MB H.264-encoded video fi le from a desktop machine hard-
wired to the server and back using the Windows browser. 

 MediaSmart MediaSmart   
 EX487 EX475

Upload Transfer 47.4 43.0
Rate (MB/s) 

Download Transfer 65.6 40.5
Rate (MB/s)

BENCHMARKS



A power user expects a phone to be an 
all-in-one communication/personal 
entertainment device that includes a web 

browser, GPS, media player, camera, SMS, and 
IM. However, if you only want to make calls and 
check your email, a smartphone doesn’t make 
much economic sense. The initial cost is high 
and monthly data plans are also expensive. Peek 
hopes its eponymous email-only device will 
catch on with people who want email on the go 
but not the other smartphone accoutrements.

The Peek is a slim (4.0”x2.7”x 0.4”) handheld 
email device with a bright 320x240 screen. It 
retails for $80 with a $20 monthly data plan. 
And if all you want is email, the Peek gets the job 
done—with some caveats. For a casual user, the 
device’s limitations may be inconsequential, but 
tech-savvy individuals will fi nd the shortcom-
ings to be deal breakers.

To get started, you simply enter the ad-
dresses and passwords of up to three accounts; 
the major providers—AOL, Gmail, Hotmail, 
and Yahoo—and numerous ISP-based services 
are supported. If you register multiple ac-

counts, though, all your email will be dumped 
into one folder, and you can’t create additional 
folders, making organization of incoming mail 
a challenge. 

Limited support for attachments is a larger 
issue. The Peek can open most image-fi le types, 
including JPEGs and GIFs, but there’s a size limit 
of 6MB per attachment and the device slows 
to a crawl as it tries to open images. Word docs, 
PDFs, and other types of attachments are not 
supported, though a spokesperson promised 
support for additional attachment types in 2009. 

Peek leases bandwidth from a wireless 
phone provider and has stated that its coverage 
is “nationwide.” While we had no problems con-
necting, sending, or receiving email anywhere 
in the Bay Area, if you live in an area with spotty 
cell reception, your experience may diff er. This 
isn’t push email, though—we generally waited 
fi ve to eight minutes for mail to arrive.

Within the narrow focus of what it promises 
to deliver, the Peek succeeds. Just who would 
fi nd this device appealing, though, is something 
of a mystery. –TOM EDWARDS

Peek 
Mobile email—and nothing else

+ -

VERDICT

$80, www.getpeek.com

6
Does what it prom-
ises to do; simple 
to use.

Not for power users. 
Small attachment limit.

LYNYRD SKYNYRD

PEEK

LEONARD PART 6

The Peek’s $20 
monthly data plan 
is a bargain—if you 
can live with the 
device’s limitations.



If it’s odd to see Samsung’s name on a note-
book, you’ll likely get used to it. While the 
company had previously sold its branded 

notebooks only overseas, it recently entered the 
U.S. market with no fewer than fi ve notebook 
lines, ranging from netbooks to the desktop 
replacement model we review here, the R610.

Actually, desktop replacement is a bit of 
a stretch, unless your expectations are pretty 
minimal. Costing little more than a grand, the 
R610 is better classifi ed as a budget notebook. 
And on fi rst look, you might be impressed 
with what can be had for so little cabbage: a 
16-inch glossy screen, a large keyboard and 
numeric pad, three USB ports, HDMI, dedi-
cated graphics, and a relatively sleek and 
lightweight design. 

But just a little time using the 
R610 is sure to bring out the critic in 
any power user. Our fi rst disap-
pointment was with the screen’s 
image quality. There’s a very narrow 
sweet spot at which the picture looks 
good. Stray from that spot either vertically or 
horizontally and the colors fade or reverse and 
the contrast is diminished—qualities suggesting 
this is a 6-bit-color panel, and not a good one at 
that. The keyboard feels similarly low rent. 

It’s no surprise then that the R610’s perfor-
mance also underwhelms. The machine sports 
a little-known Conroe 65nm Core 2 Duo Mobile 
CPU dubbed the T5800. The proc runs at 2GHz, 

which puts it at a 
disadvantage against our 
aged 2.6GHz zero-point (not to mention 
Penryn-based notebooks) in just about every 
benchmark. In our content-creation tests, the 
R610’s scores were inferior to our zero-point’s 
in all but the Photoshop benchmark, where a 
larger hard drive and more RAM likely helped 
the R610 achieve its 6.8 percent lead. By com-
parison, the HP HDX 18 notebook we reviewed 
last month bested our zero-point in all of the 
content-creation tests by 15 to 40 percent.

The R610 did score a surprising 33 percent 
win against our zero-point in Quake 4. But to 
put that win in perspective, the HP HDX 18 
from January and the Gateway P-7811 FX we 
reviewed in October trampled our test bed 
in Quake 4 by 235 percent and 375 percent, 
respectively. Furthermore, the R610’s 9200M 

GS graphics part did not hold up in FEAR, a 
better indicator of a chip’s aptitude with more 
modern games. 

The R610’s 6-cell battery provided us with 
two hours and 12 minutes of DVD movie watch-
ing with the machine in power-saving mode.

 Despite our criticisms, we’re reticent to say 
the R610 is a bad buy. There are obvious signs 
of scrimping and performance is not its strong 
suit, but we can’t imagine getting much more of 
a machine for the price. A power-user notebook 
this is not, but it’s a decent deal for serious 
bargain hunters. –KATHERINE STEVENSON

Samsung R610 Notebook
You get what you pay for

The R610’s 
glossy chas-
sis looks 
nice—until it’s 
covered with 
fi ngerprints. 
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VERDICT

$1,050, www.samsung.com

6
A multicore notebook 
for $1,000! Well-
rounded amenities.

It looks, feels, and 
performs like a bud-
get notebook.

FIRE SALE

SAMSUNG R610 NOTEBOOK

FIRESTORM

SPECIFICATIONS

CPU Intel 2GHz Core 2 Duo Mobile T5800 Intel 2GHz Core 2 Duo Mobile T5800

RAM 3GB DDR2/800MHz (2 DIMMs)

CHIPSET Intel PM45

HARD DRIVE 250GB Samsung (5,400rpm)

OPTICAL TEAC DV-W28S-R DVD burner

GPU GeForce 9200M GS

BOOT/DOWN 70 sec/35 sec

LAP/CARRY 6 lbs, 2.2 oz/7lbs, 4.3 oz

38.7 fps

2,340 sec (-20.5%)

4,350 sec (-19.6%)

12 fps (-14.3%)

2,515 sec (-3.9%)

222 sec

ZERO POINT

1,860 sec

237 sec

2,416 sec

3,498 sec

14 fps

29.1 fps

Our zero-point notebook uses a 2.6GHz Core 2 Duo E6700, 2GB of DDR2/667 RAM, an 80GB hard drive, a GeForce Go 8600M, and Windows Vista Home Premium.

Premiere Pro CS3

Photoshop CS3

ProShow Producer

MainConcept

FEAR 1.07

Quake 4

0 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%

secsec

222 

sec

sec

(-14.3%)(-14.3%)

(-20.5%)

(-3.9%)

(-19.6%)(-19.6%)

fpsfps

VISTA 32-BIT BENCHMARKS
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At first glance, the Thermaltake SpinQ 
looks like nothing so much as a stack 
of bike gears with a fan mounted 

in the center. And that’s basically what it 
is—50 circular aluminum fins mounted 
around an 80mm fan connected to a copper 
exchanger. The cooler measures 4.8” wide 
by 3.54” deep by 5.98” high—about the 
same height and width as the Zalman 
CNPS9700LED, but a bit deeper. The 
SpinQ is, essentially, the high-rise coun-
terpart to the horizontal sprawl of its 
stablemate, the Thermaltake DuOrb. 

Unlike the DuOrb, with its two fans 
and jarring red-and-blue LED color 
scheme, the SpinQ keeps to one color, 
a soothing blue, and a single fan. And 
instead of the DuOrb’s retention system, 
which is sturdy but requires you to 
remove your motherboard, the SpinQ 
uses the same plastic mounting system as 
Intel’s stock coolers, so provided you don’t 
already have a retention plate from your 
previous cooler installed, all you have 
to do is snap the SpinQ onto the moth-
erboard, tighten it, and go. Thermaltake 
definitely wins points for the SpinQ’s ease 
of installation. 

The SpinQ comes with a controller knob 
that lets you change the fan’s speed from 
low, which is whisper-quiet, to its top speed, 
which sounds like a small jet engine, and ev-
ery stop in between. It’s a handy feature—if 
you don’t mind reaching into your case, that 
is. It’s too bad that at its lowest setting the 
SpinQ barely outperforms our stock cooler. 
At its highest (and loudest), it knocked eight 
degrees from our quad core’s 100 percent 
burn temp—respectable, but not even close 
to the DuOrb’s numbers, which cooled 15 
degrees below stock at 100 percent burn. 

If your tastes run more to silver and blue 
than copper and red (and blue), the SpinQ 
is a clear winner on the design front. But it 
can’t match the performance of its sprawl-
ing, dual-fanned sibling. 

Don’t get us wrong, the SpinQ is not a 

bad cooler. It’s got looks, a fairly standard 
formfactor (as opposed to the DuOrb’s ex-
panse), and ease of installation in its favor, 
and its performance is nothing to scoff at. 
But in a fair fight, at 100 percent CPU utiliza-
tion, it can’t match up with its sibling. Both 
coolers retail for $80, so unless you’re really 
cramped for horizontal space, you’re better 
off with the DuOrb. –NATHAN EDWARDS

Thermaltake SpinQ
Is a skyscraper better than suburban sprawl?

+ -

VERDICT

$80, www.thermaltake.com

8
Good looks, easy to 
mount, respectable 
cooling power.

Same price as the 
DuOrb, without the 
performance.

SPIN CITY

THERMALTAKE SPINQ

SPIN CLASS Thermaltake Thermaltake Thermaltake
 SpinQ (low) SpinQ (high) DuOrb Stock Cooler

Idle (C) 37.5 35.5 32.75 38.8

100% Burn (C) 66.75 59.0 51.75 67.0

Best scores are bolded. Idle temperatures were measured after an hour of inactivity; load temperatures were measured after an hour’s worth of CPU 
Burn-In (four instances). Test system consists of a stock-clock Q6700 processor on an EVGA 680i motherboard.

BENCHMARKS

The Thermaltake 
SpinQ is respectable 
but not exceptional.



BenQ promises that its E2400HD LCD 
monitor will provide “a brand-new 
standard for personal digital audio-

visual entertainment….” And while we’ve 
grown weary of marketing hyperbole, at 
first glance, this 24-inch panel has the specs 
to back up this statement. The E2400HD 
sports a 1080p HDMI interface and utilizes 
a 16:9 aspect ratio (rather than the more 
common ratio of 16:10 for widescreen pan-
els), two features that should improve the 
movie-watching experience. OK, perhaps 
“brand-new standard” is a bit overboard, 
but as we unboxed it, we did think that a 
1080p 24-inch monitor for less than $400 
was certainly intriguing—even if it sports a 
6-bit panel.

A 16:9 aspect ratio should, theoreti-
cally, provide a better image when viewing 
high-def widescreen movies because a 16:10 
monitor has to either stretch an image by 
10 percent or add black bars to the top and 
bottom of the image to compensate for the 
additional space. In our tests with multiple 
DVD movies, however, those ubiquitous 
horizontal black bars appear during play-
back. While TV shows and many movies 
(typically romantic comedies) are filmed 
in a native 16:9 aspect ratio, many films 
are matted using a wide 2.35:1 aspect ratio 
where you’ll still see black bars. Therefore, 
while the BenQ is capable of displaying a 
movie in its original widescreen glory, many 
DVDs will still not be able to utilize all of the 
screen’s space.

Regardless, this is still a solid panel for 
watching high-def movies—when the moni-
tor’s Movie mode is used. In standard mode, 
V for Vendetta suff ered from a washed-out 
palette. The panel couldn’t diff erentiate the 
movie’s many dark hues and the bright white 
seemed to take on a gray cast; however, 
Movie mode upped the contrast signifi cantly, 
showing off  both ends of the color spectrum. 
Gaming was also solid; the colors in Far Cry 
were vivid and we didn’t observe any stutter-
ing or ghosting during gameplay.

Our DisplayMate tests (www.display-

mate.com) backed up what we observed in 
our real-world tests. We were able to differ-
entiate colors at both ends of the spectrum 
in the grayscale tests, and the E2400HD 
showed no color-tracking or banding issues 
when we ran DisplayMate’s scripts. 

However, the same Senseye technol-
ogy that improved our movie-watching 
experience was much less successful when 
we viewed high-def photos. With the Photo 
mode on, pictures took on a cold, blue hue. 
Standard mode seemed to present a truer 
presentation of the images colors, but lacked 
a certain vividness.

Whether the 16:9 aspect ratio will make 
any noticeable difference really depends 
on what type of content you’ll be watching; 
still, with a street price hovering around 
$350, the E2400HD is a good value. But 
even at this midrange price, we expect more 
from the stand, which allows only minor tilt 
adjustments; if we were to use this monitor 

as our primary movie-watching or gam-
ing panel, we’d prefer to also have height 
adjustment and swivel included as well. 
–TOM EDWARDS

BenQ 
E2400HD
Is this monitor built for 
Blu-ray?

+ -

VERDICT

$400, www.benq.us

6
A 24-inch LCD that 
supports 1080p for 
less than $400.

16:9 aspect ratio 
supported by limited 
number of films.

HERMEY

BENQ E2400HD

THE BUMBLE

SPECIFICATIONS

PANEL TYPE TN

RESOLUTION 1920x1080

INPUTS VGA, HDMI, DVI, audio-in

IN THE LAB REVIEWS OF THE LATEST HARDWARE AND SOFTWARE

The BenQ E2400HD provides a 1080p viewing experience—but on a 6-bit panel.
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The HP Mini 1001xx is easily the 
classiest-looking little netbook we’ve 
come across. Like most of HP’s recent 

computers, from the Blackbird to the HDX 18, 
the Mini 1001xx opts for subtle design fl air 
instead of solid colors—in this case, faint gray 
spirals on a glossy black clamshell lid. The 
interior is smooth and matte black, and the 
keys are soft  and very square but still provide 
an audible click—no mushiness here. 

The keyboard is the most comfortable 
we’ve ever used in a netbook; it doesn’t feel 
cramped at all, although those with large 
hands will still fi nd their wrists dangling 
off  the end of the board—a familiar 
story in this category.

Like the other netbooks 
we’ve tested, the Mini 
1001xx is built on Intel’s 
1.6GHz Atom proces-
sor, runs Windows 
XP, and has 1GB of 
DDR2 RAM. It has 
the smallest hard 
drive of any non-SSD net-
book we’ve tested, but we suppose 
60GB isn’t terrible. Like the Lenovo S10, 
the Mini 1001 ships with only two USB ports, 
and the Ethernet port is so well hidden as to 
be virtually invisible, but it is there, behind a 
thick rubber cover.

On the performance front, the Mini 
shuffled through our Adobe Photoshop CS3 
script in 802 seconds, nearly two minutes 
slower than the Lenovo IdeaPad S10, but it 
had no problem playing H.264-encoded MP4 
files without stuttering. It lasted two hours 
and six minutes in our battery-rundown test, 
a few minutes longer than any non-SSD-
based netbook we’ve reviewed, but certainly 
nothing to brag about. 

Interestingly, the Mini 1001xx actually 
(eventually) managed to play Quake Live, 
something no other netbook we’ve tested has 
done. We think this is more likely the result of 
updates to Quake Live’s still-in-beta code than 
anything HP’s done, since the Mini has the 
same architecture as all those other netbooks. 

Unfortunately, the 1024x600 monitor just isn’t 
tall enough to fi t the entire Quake Live game 
screen, so this ability is of questionable value. 

Perhaps in an attempt to make the Mini 
1001xx thinner, HP removed the industry-
standard VGA port in favor of a proprietary 
port, which allegedly fi ts a VGA-out dongle; 
however, one wasn’t included with our review 
unit, so we were unable to test this setup. 

The Mini is neither the fastest nor, at $490, 
the cheapest netbook we’ve tested. But it’s the 

fi rst netbook that didn’t look like a honey-I-
shrunk-the-laptop version of a bigger device—
it’s comfortable being a netbook. And we’re in 
favor of that. The Acer Aspire One still hits our 
price/performance sweet spot, but if you want 
a netbook that makes a style statement and 
don’t mind paying a bit of a premium for it, the 
Mini is your model. –NATHAN EDWARDS

HP Mini 1001xx
A netbook with panache

+ -

VERDICT

$490, www.hp.com

7
Great keyboard, 
best-looking netbook 
we’ve tested, decent 
battery life. 

Small hard drive, 
only two USB ports, 
proprietary VGA port. 

MINI COOPER

HP MINI 1001XX

D.B. COOPER

SPECIFICATIONS

Display  10.2” TFT @1024x600

Processor 1.6GHz Intel Atom N270 

Chipset  Intel 945GSE

Graphics  Intel GMA50

RAM  1GB DDR2/667

Storage  60GB Toshiba 1.8” HD

Ports   Two USB, audio in/out (single jack), 
multicard reader, proprietary video port

Wireless  Bluetooth, 802.11b/g

Lap/Carry  2lbs. 8 oz/3lbs. 1oz

We can’t say 
enough good 

things about 
the Mini 1001xx’s 

keyboard. 

PHOTOSHOP (SEC)  802

BATTERY (HRS:MIN)  2:06

H.264  Yes

QUAKE LIVE  Yes

BENCHMARKS
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Western Digital’s WD TV HD Media 
Player is missing two components 
commonly found in digital media 

players: a display and storage. What the de-
vice does have is two USB ports, HDMI and 
composite video outputs, digital and analog 
audio outputs, and the ability to play almost 
any digital media. 

Since you provide the storage media, 
you can never fill up the WD TV. You plug 
the player into your TV and connect your 
USB drive or digital camera to the player; 
it then creates thumbnails for all the digital 
movies, photographs, and music it finds 
stored there. If you connect storage devices 
to both USB ports, the WD TV will index the 
contents of both drives as if they were one. 

The device delivers much higher video 
resolution than most media players, all the 
way from 480i using the composite video 
port to 1080p using HDMI (576p, 720i, 720p, 
and 1080i are also supported via HDMI). The 
WD TV supports a host of video formats, co-

decs, and containers, including AVI, H.264, 
QuickTime, VOB, and Matroska. It does not, 
however, support DivX. 

The player supports most digital photo for-
mats, including BMP, TIFF, PNG, and GIF at res-
olutions up to 2048x2048; JPEG is supported 
at resolutions up to 4096x4096. Video quality 
via HDMI is excellent. High-res photos stored 
on the 250GB WD Passport drive we used took 
an average of 3.7 seconds to appear on the 
screen, which is plenty fast for slideshows, but 
the device’s browser soft ware is ploddingly 
slow about generating thumbnails. And while 
it can play slideshows while simultaneously 
streaming music, you can’t queue up the music 
and start both at the same time.

Speaking of music, the WD TV supports 
almost all the popular file and container 
formats, including AAC, FLAC, MP3, Ogg, 
and WAV. We do wish, however, that it sup-
ported WMA Lossless. The player displays 
album art and artist, album, and track name 
information stored in id3 tags, but it doesn’t 

inform you about the codec and bitrate used 
to encode the track. And it’s a good thing the 
player has an optical S/PDIF output, because 
it has an atrociously bad DAC. 

The WD TV is a ripper-friendly solu-
tion for anyone who doesn’t have an HTPC, 
media-center extender, or other type of me-
dia streamer—and doesn’t want one. It’s also 
useful for taking media on the go (provided 
there’s something to connect it to when you 
get there). –MICHAEL BROWN 

WD TV HD Media Player 
Well played, Western Digital 

Western Digital designed a 
very good remote control for 

the WD TV HD; it’s comfortable to 
hold and includes all the appropriate 

functions for the user interface, including a 
Home button that takes you to the root menu. 

+ -

VERDICT

$130, www.westerndigital.com

8
Supports a host of 
popular media for-
mats, codecs, and 
containers.

Awful DAC; doesn’t 
support DivX, WMA 
Lossless, or any 
encrypted media.

RIP

WESTERN DIGITAL WD TV HD

TRIP



Samsung SH-S223
 We weren’t clamoring for faster DVD burns, but we’ll take ’em

We’ll admit we’ve been perfectly 
content with Samsung’s SH-S203 
DVD burner for more than a 

year. Once we were writing 4.38GB of 
data to a disc in five minutes flat, we 
were feeling pretty satisfied with the 
state of DVD technology. Nevertheless, 
we’re not about to turn our nose up at a 
performance increase. And that’s what 
Samsung’s latest DVD burner, the SH-
S223, offers. 

As you might have guessed from the 
name, the SH-S223 represents a jump 
from 20x to 22x DVD+/-R burn speeds. 
In our tests, this effectively shaved 
12 seconds off the time it took to fill a 
single-layer DVD+R disc. The SH-S223 
took 4:46 (min:sec) compared with the 

SH-S203’s flat 5:00. In both cases, we used 
16x media, the fastest-rated media that’s 
readily available. And in both cases, the 
drives’ “over-speed” feature enabled them 
to burn data at higher than rated speeds. 
In the course of its write, the SH-S223 
steadily climbed from a starting speed of 
8.38x to 20.7x. 

Besides the boost in DVD+/-R speeds, 
however, the SH-S223 has identical speed 
ratings to its predecessor for all other types 
of media. In our DVD+R DL write test, 
the SH-S223’s 16x rating for that media 
amounted to a write time of 13:13 using 8x 
media, a mere three seconds slower than the 
SH-S203. Again, the SH-S223’s over-speed 
feature kicked in, with a good portion of the 
burn occurring at 10x speed. 

The SH-S223 is rated 
at 8x for DVD+RW and 6x 
for DVD-RW. We tested the 
drive with DVD-RW media 
rated at 4x. This time, rather 
than burning beyond the 
disc’s speed rating, the SH-
S223 stuck to it, maintain-
ing a 4x speed throughout 
and writing 4.38GB to the 
rewriteable disc in 14:56. 

This isn’t all that surprising, as drives typi-
cally perform much more conservatively 
with rewriteable media, given its greater 
propensity for write errors. 

Like the SH-S203 before it, the 
SH-S223 connects to a PC using a SATA 
interface and comes bundled with a host 
of Nero apps.

While we see no need to graduate from a 
20x DVD burner—particularly the SH-S203—
to the SH-S223, this is the drive to get if 
you’re currently using anything less than an 
18x model. –KATHERINE STEVENSON

The SH-S223 is 
indistinguishable 
from its prede-
cessor in looks 
and the majority 
of its features.
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VERDICT

$80, www.samsung.com

9
All the goodness of 
the SH-S203, plus 
faster DVD+/- writes.

We’d have preferred 
speed improvements 
across the board.

BIG BEN

SAMSUNG SH-S223

BIG BROTHER

Best scores are bolded. All tests were conducted using Nero CD DVD Speed and Verbatim media. 
Our test bed is a Windows XP SP2 machine using a 2.66GHz Intel Core 2 Quad Q6700, 2GB of Corsair 
DDR2/800 RAM on an EVGA 680 SLI motherboard, one EVGA GeForce 8800 GTS card, a Western 
Digital 500GB Caviar hard drive, and a PC Power and Cooling Turbo Cool PSU.

BENCHMARKS

 Samsung SH-S223 Samsung SH-S203

DVD+R Write Speed Average  14.94x 13.45x

DVD+R Read Speed Average  12.16x 12.13x

Access Times (random/full) 117/204ms 116/198ms

DVD+DL Write Speed Average  9.12x 9x
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Sacred 2 is a hack-and-slash Diablo clone 
in the vein of Titan Quest, the late and 
much-lamented Mythos, and, of course, 

2004’s Sacred. And thanks to the original game’s 
popularity, Sacred 2 is also the most-anticipated 
Diablo clone—other than Diablo 3, of course.

Much of Sacred 2 will feel pretty familiar 
if you’ve played Diablo—from the loot 
system, to inventory management, to the 
mobs-everywhere clickfest that is combat, to 
the screen-fi lling bosses. 

But dedicated hack-and-slashers will fi nd 
plenty to love in Sacred 2. The game world is 
huge and nonlinear—there are more than 22 
square miles to explore. It’s bigger than Oblivion, 
bigger than Fallout 3. Unfortunately, most quests 
take place within a few hundred yards of the 
roads, and most of the stuff  in the middle, though 
occasionally interesting or whimsical, can be 
skipped. The graphics are pretty, but not revolu-
tionary, even at the highest settings.

In Sacred 2, T-Energy threatens to destroy 
Ancaria, and you have to choose whether to 
save or destroy the world. Six diff erent classes 
play two diff erent campaigns, each about 40 
hours long if you skip the side quests. Each class 
also gets a few unique quests, including one that 
lets you buy a powerful class-specifi c mount. 
Power-gamers, rejoice: With a level cap of 200, 
thousands of items, customizable combat runes, 
and several diffi  culties from bronze to hardcore, 
which features character permadeath, there are 
easily hundreds of hours of fun to be had. 

That said, we hated the fi rst few hours of 
Sacred 2. The story was vague and the default 

fi xed camera was atrocious (fi nding just the 
right angle in a dungeon so that you can see 
both yourself and your target is surprisingly 
diffi  cult, though you get used to it aft er a while). 
The AI is nearly nonexistent, the pathing is 
quirky, and the quests, other than the main one, 
are mostly trivial. Also, it’s not 2001 anymore. 
Can we please have a viewable area that’s 
bigger than 60 feet? Or an over-the-shoulder 
camera? But somewhere toward the beginning 
of chapter two (of 10), the game hooked us, 
despite its shortcomings.

Maybe the character’s oft -muttered 

witticisms started getting through. Maybe it 
was the game’s incessant jolts of fourth-wall-
breaking silliness—we were Rick-rolled by a 
gravestone in a cemetery, attended an in-game 
concert by real-life metal band Blind Guard-
ian, and on one lonesome road found a shack 
labeled “Bus Stop.” Or maybe it was the giant 
monitor lizard our ranged-weapon-special-
izing Dryad got as a steed that made combat 
feel like driving a big stompy tank down the 
highway. Whatever it was that bit us, it bit us 
hard—we haven’t slept in days.

Although it has online and LAN multiplayer 
modes, Sacred 2 is essentially a massively single-
player game. If you love MMOs for their me-
chanics and game worlds but hate the troglodyte 
players who inhabit them, grab a few friends and 
hop into Ancaria. It’s not perfect by any means, 
but like the tortoises you’ll occasionally mangle 
in-game, if you bash through the hard outer 
shell, there’s plenty of delicious meat on the 
inside. –NATHAN EDWARDS

Sacred 2: Fallen Angel
Over time, we learned to dig this hack-and-slash adventure

+ -

VERDICT

$50, www.sacred2.com, ESRB: M

7
Huge game world, 
large amounts of loot, 
cool mounts, and big 
bosses.

Frustrating camera, 
terrible AI, uncompel-
ling side quests. 

KILLA

SACRED 2: FALLEN ANGEL

FILLA

Each class has a unique mount available. We named our fi ghting lizard Stompy!

Sacred 2’s environments are lush and varied, but the enemies within each zone are a little similar.
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Why I’m buying, not building, a home server

My power bill is bad every month, 
especially considering that I don’t 
need a heater where I live. Sure, 

my wife works at home all day, and we do 
about 9,000 loads of laundry a week, but 
my computer gear always gets the blame 
when the big bill hits. So after I’d hooked 
my wife on the benefits of an always-on 
home server—streaming audio and video 
as well as constant backups—I suggested 
we invest in an OEM-built home server, 
such as the HP MediaSmart EX475 that I reviewed this month (page 
86). While the MediaSmart is underpowered compared to my last 
gaming rig (which metamorphosized into my home server), it also 
draws a fraction of the power, roughly 10 percent according to my 
trusty watt meter. That along with setting the server to automatical-
ly turn off when it isn’t needed should make for substantial savings 
on my power bill this winter.

WILL SMITH
EDITOR-IN-CHIEF

GORDON MAH UNG
SENIOR EDITOR

As someone too 
cheap to pay for any-
thing beyond basic 
cable and standard 
def, I’m surprisingly 
pleased with Win-
dows Vista’s Media 
Center capabilities. 
With a Linksys Media 
Center Extender and 
a pair of ATI TV tuner 
cards in my offi  ce PC, 
I get absolutely silent 
access to more than 
1,000 hours of TV on 
my aged tube.

TOM EDWARDS
MANAGING EDITOR

This year, I managed 
to do all my shop-
ping without step-
ping into the mall or 
the post office. And 
while this turn of 
events has certainly 
kept my blood 
pressure down, my 
hope is that by next 
year teleportation 
technology matures 
to a point where I 
won’t have to enter 
an airport either.

NORMAN CHAN
ONLINE EDITOR

Will recently clued 
me in to Boxee, 
an amazing media 
center front-end 
that pulls Internet 
video from sites like 
Hulu, YouTube, and 
Comedy Central. The 
program is still in al-
pha, but the interface 
is intuitive and video 
streaming is seam-
less. Too bad it’s (so 
far) only available for 
Mac OS X and Linux!

NATHAN EDWARDS
ASSOCIATE EDITOR

This month I ventured 
into the world of 
Ancaria for my Sacred 
2 review, which really 
cut down on my sleep 
time. I learned that 
Ancaria has a lot of 
rats in it! The HP Mini 
1001xx, on the other 
hand, is rat-free, and 
has a really comfort-
able keyboard. I also 
learned that the Ther-
malTake SpinQ is not 
pronounced “spink.”

KATHERINE STEVENSON
DEPUTY EDITOR

What could be wrong 
with upgrading my 
Wi-Fi router to a new-
er model with WPA 
encryption? Well, if 
the router operates on 
the 2.4GHz band—as 
my new one does—it 
can confl ict with the 
two cordless phones I 
rely on at home. That’s 
the lesson I learned 
this month. So I’m trad-
ing said router in for a 
dual-band model. 



Win Rig of the Month
To EnTEr: Your submission packet must contain your name, street address, and daytime phone number; no 
fewer than three high-res JPEGs (minimum size 1024x768) of your modified PC; and a 300-word description of 
what your PC represents and how it was modified. Emailed submissions should be sent to rig@maximumpc.
com. Snail mail submissions should be sent to Rig of the Month, c/o Maximum PC, 4000 Shoreline Court, Suite 
400, South San Francisco, CA 94080.

The judges will be Maximum PC editors, and they will base their decision on the following criteria: creativity 
and craftsmanship.

onE EnTry pEr housEhold. Your contest entry will be valid until (1) six months after its submission or (2) 
the contest ends, whichever date is earlier. Each month a winner will be chosen from the existing pool of valid 
entries, and featured in the Rig of the Month department of the magazine. Each of the judging criteria (creativity 
and craftsmanship) will be weighed equally at 50 percent. By entering this contest you agree that Future US, 
Inc. may use your name and your mod’s likeness for promotional purposes without further payment. All prizes 
will be awarded and no minimum number of entries is required. Prizes won by minors will be awarded to their 
parents or legal guardians. Future US, Inc. is not responsible for damages or expenses that the winners might 
incur as a result of the Contest or the receipt of a prize, and winners are responsible for income taxes based 
on the value of the prize received. A list of winners may also be obtained by sending a stamped, self-addressed 
envelope to Future US, Inc. c/o Maximum PC Rig of the Month, 4000 Shoreline Ct, Suite 400, South San 
Francisco, CA 94080. This contest is limited to residents of the United States. No purchase necessary; void in 
Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

If chosen, your rig will be featured before all the world in Maximum pC—and you’ll 
win a $250 gift certificate
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AV Alternatives
I just finished reading the 
antivirus roundup by Paul 
Lilly in the January 2009 
issue and found it to be 
informative, to a point. 
It seems like McAfee and 
Symantec always get 
included in these reviews 
by default. I would be 
interested in seeing how 
Computer Associates and 
Trend Micro compete with 
the Dynamic Duo. I have 
used both and find it invalu-
able to use their online ser-
vices as well as their home 
computer products. 

 —Steve Gardner

Deputy Editor Katherine 
Stevenson Responds: 
Practically anytime we do 
a review roundup we have 
to limit the number of prod-
ucts we can cover—this 
isn’t simply a matter of time 
and resources; it also keeps 
a single story from taking 
up too much space in the 
magazine. In choosing the 
10 antivirus products for our 
January feature, we tried to 
select a mix that would be of 

greatest interest to enthusiast 
users, but inevitably, some 
worthwhile products were 
left out. We appreciate your 
suggestions and will certainly 
take those apps into consider-
ation the next time we do an 
AV story.

Mac Pro vs. PC
I would like to see you 
guys do a competitive 
comparison of the Mac Pro 
workstation booted directly 
into Windows (using Boot 
Camp) against comparable 
PCs. Why is this interest-
ing? Because for technical 
applications (data acquisi-
tion, video capture, etc.) 
there’s way more hardware 
and software for the PC 
than for the Mac. On the 
other hand, for day-to-day 
use (word processing, pre-
sentations) and particularly 
when accessing the Internet 
(email, web), it’s more 
sensible to be in the Mac 
universe, if for no other rea-
son than not to have to deal 
with Windows’s incessant 
bugs and security holes. The 
ideal setup for me would be 
a single box that runs Mac 
OS X when connected to the 
Internet and for standard 
office work but which can 
be booted into Windows 
(and disconnected from 
the Internet as desired) 
for specialized technical 
applications. 

The question is, how 
does such a setup compare 
to a standard PC worksta-
tion? It seems to me that 
this topic would be of great 

interest to hardware geeks 
like us who subscribe to 
Maximum PC.

 —Cahit Kitaplioglu

Senior Editor Gordon Mah 
Ung Responds: I simply 

don’t see a reason to do this 
comparison. As far as I’m 
concerned, a Mac Pro is not 
worth the premium price 
when you can actually get 
more performance from a 
Core i7 (which is not avail-

Maximum PC reader (and Jack Black lookalike) Keith 
Whisman introduces us to a future MPC acolyte, his 
newborn son. Daniel Joseph Whisman was born 
on December 3 at 11:25 a.m., and we found Keith 
celebrating by posting comments on our website a 
mere hour later—a true testament to his devotion 
to our magazine. Meet Keith and other readers 
on the message boards and discussion threads at 
MaximumPC.com! 

PHOTO OF THE MONTH

MPC’s Newest Fan

We tackle tough reader questions on...

Mac vs. PCSAS DrivesMac vs. PCSAS DrivesMac vs. PC

H.264 on a Netbook

COMMENTS YOU WRITE, WE RESPOND

CUTCOPYPASTE 

Our January 2009 article “How 
to Connect Your PC to Your 
Surround-Sound Audio System” 
contained a factual error. Motherboards 
using Nvidia’s nForce 750i, 790i, or 
780i chipsets are capable of sending six 
channels of compressed digital audio 
(e.g., Dolby Digital and DTS) over an 
internal S/PDIF cable. 
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Phenom II
Will AMD’s new 45nm Phenom 
reclaim the hearts and minds 

of power users? Tune in for 
the full results of our hands-

on tests.

able on Macs yet) with many 
of the apps you will likely 
run. And if you’re worried 
about security, you should 
know that Windows Vista 
has actually consistently out-
scored the vaunted OS X in 
security exploits discovered, 
and Microsoft is far faster 
at addressing security holes 
than Apple is.

H.264? Really?
I was very impressed with 
your reviews of various 
netbooks in the December 
2008 issue. It came out just 

as I was looking to buy 
a netbook, so the timing 
could not have been more 
perfect. I picked up the 
Acer Aspire One and am 
loving it. I do have a ques-
tion for you, though.

In the review, under 
Benchmarks, it states that 
the Aspire One can run 
H.264-encoded video. I’ve 
been trying to run some of 
the same on mine, but there 
is a great deal of stuttering 
in the video.

Additionally, the video 
is playing slower than the 
audio. Did you experience 
this in your benchmarks? 
The write-up itself makes no 
mention of how the H.264 
video test is executed, but 
from the information in the 
table and the description 
of the test, I assumed it was 
possible to run video but not 

encounter these issues.
—Craig Currier

Associate Editor Nathan 
Edwards Responds: Sorry 
for the confusion, Craig. 
The video file we used was 
a 1.92GB MP4, encoded 
with the avc1 H.264 codec 
at 720x358 at 1536KB/s, 
played back in Cyberlink 
PowerDVD 8. The maximum 
resolution of most netbooks 
is 1024x600. 
 You should have no 
trouble playing DVD-quality 
video, but we wouldn’t rec-

ommend anything higher 
than that. If you don’t want 
to spring for the full version 
of PowerDVD 8, the free VLC 
player works fine too.

Taking It One Tip 
Further
Please make sure you let 
your readers know that 
when they disable the 
splash screen (“Windows 
Tips,” Holiday 2008) they 
will no longer see the check 
disk process, so before they 
do a check disk they should 
go back to boot.ini tab and 
uncheck/NOGUIBOOT. 

—Brian M., aka FreeWay

Getting SASsy
With the cost of your 
Dream Machine, why didn’t 
you consider the Seagate 
Cheetah 15K.6 and Savvio 
15K.2 drives? From 

their spec sheets, these 
would seem even faster 
than the Western Digital 
Velociraptors you chose.
  I realize those other 
drives are more expensive 
but not so much more that 
an enthusiast wouldn’t still 
consider them. I put a 15K 
Cheetah (older model) in 
a system a few years back 
and was blown away by 
its better performance. I’d 
definitely be interested 
in seeing a review in your 
magazine sometime.

—Scott Albrechts

Associate Editor Nathan 
Edwards Responds: Both 
the Cheetah and Savvio 
are quite fast. But neither 
is available with a SATA 
interface. Although both 
drives come in a SAS (serial-
attached SCSI) flavor with a 
SATA-type connector, SAS 
devices cannot run on SATA 
controllers, while SATA 
devices can run on SAS 
controllers. And SAS drives 
are still ungodly expen-
sive, even compared to the 
Velociraptor.

Most enthusiast moth-
erboards don’t have SAS 
controllers, although 
that’s changing—the Intel 
D5400XS we used in our 
Dream Machine has one. 

We typically haven’t 
considered enterprise or SAS 
drives when building our 
machines, but as SAS speeds 
get faster (up to 6Gb/s this 
year) and more boards start 
supporting SAS again, we’ll 
look into it—expect a SAS vs. 
SATA Deathmatch later this 
year. Thanks for bringing the 
issue to our attention! 
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about making the most of 
your digital video collection.

Rip, Burn, 
and Stream

2008 Gaming 
Awards
Join us as we honor the best 
games and gaming moments 
from the last year. Hint: 
Expect to see zombies.

A MAC PRO IS NOT  WORTH THE 
PREMIUM PRICE WHEN YOU 
CAN GET MORE PERFORMANCE    
FROM A CORE I7. 



Each issue of
Maximum PC features:
� Brutally honest product

reviews

� Hard-hitting editorials

� Tips to blast your
machine’s performance

� Insightful and
innovative How-To’s

� A CD loaded with new
software, utility and
game demos

Reserve your 2 FREE
Trial Issues today!
There’s no obligation.

To order, head to:
www.maximumpc.com/archive

Unleash your PC’s Potential…
Try

2
FREE
Trial Issues
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RIG OF THE MONTH  
ADVENTURES IN PC MODIFICATION

BE A WINNER!
For submitting this month’s winning entry, Richard has won a 
$250 gift certifi cate. To enter the Rig of the Month contest, 
see the offi cial rules on page 101.

MAXIMUM PC (ISSN 1522-4279) is published 13 times a year, monthly plus 
Holiday issue following December issue, Future US, Inc, 4000 Shoreline Court, 
Suite 400, South San Francisco, CA 94080, USA. Periodicals postage paid in South 
San Francisco, CA, and at additional mailing offices. Newsstand distribution is 
handled by Time Warner Retail. Basic subscription rates: one year (12 issues) 
US: $20; Canada: $26; Foreign: $42. Basic subscription rates “Deluxe” version 
(w/CD): one year (13 issues/13 CD-ROMs) U.S.: $30; Canada: $40; Foreign $56. 

US funds only. Canadian price includes postage and GST (GST#R128220688). 
Postmaster: Send changes of address to Maximum PC, P.O. Box 5159, Harlan, 
IA 51593-0659. Standard Mail enclosed in the following edition: B1. Ride-Along 
enclosed in the following editions:  C1, C2, C3, C4. Int’l Pub Mail# 0781029. Canada 
Post Publications Mail Agreement #40043631. Returns: Bleuchip International, 
P.O. Box 25542 London, ON N6C 6B2. For customer service, write Maximum PC, 
P.O. Box 5159, Harlan, IA 51593-0659; Maximum PC, 4000 Shoreline Court, Suite 

400, South San Francisco, CA 94080. Future Network USA also publishes PC 
Gamer, PlayStation: The Official Magazine, Mac|Life, Nintendo Power, Guitar 
World, Revolver, Official Xbox Magazine, and Pregnancy. Entire contents copy-
right 2008, Future Network USA. All rights reserved. Reproduction in whole or 
in part is prohibited. Future Network USA is not affiliated with the companies or 
products covered in Maximum PC. PRODUCED AND PRINTED IN THE UNITED 
STATES OF AMERICA.

Some people want their rigs to be an approxima-
tion of what computers will look like at some 

point in the far-off future. Richard Clinton, though, 
wanted to look back to a simpler time: the 8-bit era. 
But while computer technology was less complex 
back then, building the Black Mage was anything 
but easy.

In order to re-create his favorite Final Fantasy II 
character type, Richard organized, glued, and paint-
ed 2,000 1”x1” cubes. All told, it took four months to 
assemble the Black Mage. To see the process short-
ened to 10 minutes, check out Richard’s build video 
at www.youtube.com/watch?v=VoUVgK65FIA.

xxxxxxxxxxxxx-
inged dual 22-inch 
LCD monitors. To 
create this rig, 
Will took apart his 
laptop to see how 
the hinges and body 
panels worked and 
then copied the 
design. 

To keep all this hardware cool, Richard raised the motherboard 
an inch above the wood blocks and installed two 250mm fans. 

Black Mage8-BITBlack Mage8-BITBlack Mage

A USB 
plasma 
orb (above) 
found at 
Think Geek 
completes 
the look.
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